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Introducing Xplorer
Xplorer is a media management application that allows you to browse and manage the 
media content stored on the Xmedia Server (XMS) and other devices. 

More specifically, Xplorer allows you to:
• Quickly identify and monitor the status of the Xmedia Server and other devices that are 

configured and/or connected to your system. 
• Browse and manage the media content stored on the Xmedia Server and/or other 

devices.
• Move content to and from the Xmedia Server and other devices, including ingesting 

content from external storage devices and converting the imported files into Vertigo 
compatible assets.

• Preview the playout of various asset types that are stored on the Xmedia Server or 
devices.

• Create and manage work order requests for graphics elements that are required but do 
not exist on the system.

The following sections provide information and instructions for using Xplorer:
• Getting started with Xplorer, on page 3
• Browsing and managing media on the XMS and other devices, on page 15
• Moving assets to/from the XMS and other devices, on page 31
• Previewing assets in Xplorer, on page 53
• Xplorer’s commands and settings, on page 63
• Creating and using work orders, on page 75
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Getting started with Xplorer
To help get you started using Xplorer, this chapter provides you with information about 
installing and licensing the Xplorer software. Once installed, you must configure Xplorer to 
recognize and actively connect with the Xmedia Server and the other devices. 

Information and instructions to help you set-up and familiarize yourself with Xplorer are 
provided in the following sections:

• Installation and licensing information, on page 4
• Starting Xplorer and connecting to the Xmedia Server, on page 5
• Overview of Xplorer’s interface, on page 7
• Configuring Xplorer’s settings, on page 9
• Adding devices to Xplorer’s Device Viewer, on page 10
• Connecting a device to Xplorer, on page 13
 3
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Installation and licensing information
Xplorer is packaged with the Vertigo Suite software installation wizard. It can be installed as 
part of the full installation or as an individual (standalone) component. In both cases, you 
simply need to run the installation wizard on a workstation that is on the same network as 
the Xmedia Server.

Information regarding the Vertigo Suite’s hardware and network requirements, as well as 
instructions for installing and/or upgrading Xplorer, are available in the Vertigo Suite’s 
Release Notes, which can be downloaded from the Documentation Library on the Grass 
Valley Web site (www.grassvalley.com).

Xplorer requires that a software application license be installed and validated on the 
Xmedia Server. Therefore, once Xplorer is installed, you must contact our Support team 
(support@grassvalley.com) to request a license key for Xplorer. Then you must apply and 
validate the license using the Vertigo Suite’s License Manager, which stores the license on 
the Xmedia Server. Instructions for acquiring and validating an Xplorer application license 
are provided in the Vertigo Suite’s Release Notes. 

Note: Xplorer will not operate properly unless its connection to the 
Xmedia Server is active and a valid license is present. See page 5 for 
more information about resolving connection and license errors.
4
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Starting Xplorer and connecting to the Xmedia Server
As a client application, Xplorer must always be connected to the Xmedia Server, which is 
the centralized asset management server and license manager for Vertigo applications and 
devices. 

Each time Xplorer is opened, it verifies the connection to the Xmedia Server and the 
availability of the Xplorer license. If both conditions are successful, then Xplorer opens and 
is ready to be used. However, if either of these conditions is unsuccessful, an error message 
appears and prompts you to remedy the situation (see below).

While using Xplorer, the connection to the Xmedia Server must always be maintained 
(active). As such, Xplorer continuously verifies and reports the connection status using the 
XMS icon in the Xmedia Server Viewer. Figure 2-1 demonstrates the two states of the XMS 
icon’s connectivity status.

Fig. 2-1: Xplorer’s Xmedia Server connection status

If for any reason the connection to the Xmedia Server fails (disconnected), you must re-
establish the connection before continuing to use Xplorer. 

The following sections describe how to resolve situations in which Xplorer cannot connect 
to the Xmedia Server or find a valid license on startup.

Resolving an Xmedia Server connection failure when opening Xplorer:
1 Open Xplorer by clicking VertigoXmedia>Xplorer from the Windows Start menu.

If Xplorer cannot successfully connect to the Xmedia Server, an error message appears.
2 Click Yes and Xplorer’s Settings window opens and displays the XMS page.
3 In the Xmedia Server IP Address field, type the IP address of the machine hosting the 

Xmedia Server.
4 Unless the port number was changed when the Xmedia Server was installed, the 

default in the XmediaServer Port field will be correct. If it was changed, enter the new 
number.

5 Click OK.
Xplorer should now open. If Xplorer still cannot connect to the Xmedia Server, consult 
your system administrator. The problem could be due to one of the following:

Note: Common reasons for losing the connection are that the Xmedia 
Server or the machine hosting Xplorer has lost its network connection 
(network is down, IP address has changed or network cable 
disconnected), the Xmedia Server service has been stopped, or the 
Xmedia Server machine has been shutdown or has crashed.

Xplorer is actively 
connected to the
Xmedia Server

Xplorer has been
disconnected from
the Xmedia Server
5
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• The IP address or port was entered incorrectly.
• The machine hosting the Xmedia Server is down.
• The Xmedia Server is not running on the host machine.
• The machine is not connected to the network.

Resolving a license failure when opening Xplorer:
1 Open Xplorer by clicking VertigoXmedia>Xplorer from the Windows Start menu.

If Xplorer cannot successfully locate a valid Xplorer license on the Xmedia Server, an 
error message appears.

2 Evaluate and act according to the following:
• If you suspect that the cause of the license error is that the Xplorer license has not 

yet been installed and validated on the Xmedia Server, click Enter License. The 
License Manager opens and you can follow the instructions in the Release Notes 
for acquiring and installing a software license.

• If you suspect that the cause of the license error is that Xplorer is connected to the 
wrong Xmedia Server (the license resides on another Xmedia Server), click Change 
Server. Xplorer’s Settings window opens and displays the XMS page. In the 
Xmedia Server IP Address field, type the IP address of the Xmedia Server that 
holds a valid Xplorer license. Click OK.
6
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Overview of Xplorer’s interface
While further chapters provide full procedural instructions for using Xplorer, this section 
lists Xplorer's main interface components and provides brief functional descriptions of 
each.

Fig. 2-2: Xplorer’s user interface components

1 Menu commands - The menu commands provide access to Xplorer's settings and 
administrative functions. See Xplorer’s menu commands, on page 64 for a full 
description of each command. 

2 Toolbar buttons - The toolbar buttons offer easy access to the features and functions 
that are most commonly needed when using Xplorer. Functional descriptions for each 
of these buttons is described within the procedures for using Xplorer, as well as 
Xplorer’s toolbar buttons, on page 66.

3 Search XMS - The Search XMS text box allows you to quickly search and find assets on 
the Xmedia Server using a typical search engine component. Once a search is 
launched, assets that match the name, type, description, author, keywords and/or 
Recall ID are returned in the XMS Search Results View and displayed in either a Proxy 
View or Detailed View and ordered by relevance. See Searching for assets stored on the 
Xmedia Server, on page 19.

4 Asset Browser - Located along the left-side of the interface, the Asset Browser is a 
collapsible panel that provides a hierarchical view of the root categories and sub-
categories in which assets are stored on either the Xmedia Server or the device that is 
currently selected in the Device Viewer. Upon selecting a category, the assets are 
displayed in the Asset Gallery.

5 Asset Gallery - Identifies the assets that are stored within the asset category selected in 
the Asset Browser. When the Proxy View button  is enabled in Xplorer’s toolbar, the 
assets are displayed as labeled-thumbnail images. When the Detail View button  is 
enabled, the assets are displayed in a list that identifies the asset’s name along with 
some of its current properties.

1

4

6

2

5

7

3
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6 Xmedia Server Viewer - Identifies the Xmedia Server (hostname or IP address) and its 
current connection status to Xplorer (see page 5). When you select the XMS icon, the 
contents of the Xmedia Server are displayed in the Asset Browser and Asset Gallery.

7 Device Viewer - Displays an icon for each of the devices that are managed by the 
Xmedia Server, as well as their current connection status to Xplorer (see page 13). 
When the View>Show Device Details menu command is enabled, some of the devices’ 
statistics are displayed (i.e. the percentage of free space on their disk, as well as the 
number of items left in the publish queue.) See page 45 for more information.
When you select a device’s icon, the contents of that device are displayed in the Asset 
Browser and Asset Gallery.
Right-clicking on the device’s icon exposes commands that you can use to launch 
various functions associated with the device (e.g. ping the device, launch the device’s 
Publish Queue Monitor, launch the device’s Dashboard or display the device’s 
properties).
8
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Configuring Xplorer’s settings
While Xplorer’s default settings are appropriate for most operating circumstances, you may 
want to customize the look and behavior of the application using Xplorer’s settings. Note 
that modifying the settings is entirely optional.

Changes to Xplorer’s settings are made in the Settings window, which can be accessed by 
selecting the Tools>Settings menu command. 

The Settings window has six thematic tabs, which contain properties and settings that 
apply to Xplorer. A functional description of each setting is provided in a quick reference 
format in the following sections of the appendix chapter:

• XMS settings, on page 68
• Work Order settings, on page 69
• Layout settings, on page 70
• Publish Monitoring settings, on page 71
• General settings, on page 72
• Logging settings, on page 73

Note: Some settings will require you to restart Xplorer for the changes 
to be applied.
9
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Adding devices to Xplorer’s Device Viewer
Xplorer uses the Vertigo Suite’s Device Manager to identify the output devices that are 
available and associated with the Xmedia Server. The Device Manager contains the user-
defined device configuration profiles that allow Vertigo Suite applications (i.e. Xplorer, 
Xstudio, Xplay...etc.) to connect to and communicate with specific output devices on the 
network.

Since several applications in the Vertigo Suite are capable of defining devices on the 
Xmedia Server, it is possible that the device configuration profiles of some of the devices on 
your network are already present in the Device Manager. As such, when you open Xplorer 
and it is connected to the Xmedia Server, the devices that already exist in the Xmedia 
Server will appear in Xplorer’s Device Viewer (Figure 2-3). If the Device Viewer does not 
contain an output device that you need, you must add the device’s configuration profile to 
the Device Manager.

Fig. 2-3: Xplorer’s Device Viewer is populated with the devices from the Xmedia Server

To add a device to Xplorer’s Device Viewer:
1 Select the Tools>Configure Devices menu command. 

The Device Manager window (Device Configuration) opens. 
Note that the Device Manager displays the device profiles that were previously added 
to the Xmedia Server.

2 Select the New button in the lower-left corner.
The Device Configuration section (lower portion) immediately changes to become the 
New Device Information section, which features two tabs (General and Advanced) 
upon which are a series of empty fields for specifying the new device’s configuration 
details.

Xplorer’s Device Viewer
displays all of the devices
from the Xmedia Server.
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3 Specify the appropriate General Device Configuration settings:

Device name The name of the device. Note that the name cannot be modified after the 
device configuration profile has been added to the Device Manager.

Device alias An optional field that provides an alternative name for the device on your 
network.

Description An optional field that lets you identify the device using a meaningful label. 
This is helpful for distinguishing similar devices at your facility.

Device Type Identifies the type of device that these settings apply to. 
Choose from:
• VertigoXG
• IntuitionXG
• Preview (or other device)
• Remote Renderer
• ImageStore
• Intuition
• HMP
• FTP
• LGK
• DSK
• Other
Note: Always select Preview (or other device) for Software CG devices.

Control IP The network location (IP address) or hostname of the selected device. The 
host must be available on the network.
Note: The Control IP setting is not displayed when HMP is selected as the 
device type.

Control Port The networking port that serves as a channel for sending commands to and 
from the device.
Note: The Control Port setting is not displayed when HMP is selected as the 
device type.

Publish IP The network location (IP address) or hostname of the of the machine to 
which assets are published when publishing to the selected device. This is 
usually set to the same address as the Control IP. Note that the host must be 
available on the network.
Note: The Publish IP setting is not displayed when Vertigo XG, Intuition XG 
or Intuition are selected as the device type.

Publish Port The networking port that serves as a channel for publishing assets. Typically, 
this value is set to 15000.
Notes: 
• The Control Port setting is only displayed when Preview, FTP, HMP or Other are 

selected as the device type.
• This value must correspond with the port used by the XpublishAgent on the output 

device.

Publish as 
Export

The Publish as Export setting is only displayed if FTP is the selected device 
type.
This setting publishes the asset in the Vertigo Export (.vex) zip file format. 
The VEX format is used by the File Ingest Service to import assets into the 
Xmedia Server.
11
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4 Specify the appropriate Advanced Device Configuration settings:

5 Click Save and the device configuration profile is added to the Xmedia Server and 
displayed in the Device Manager.

6 Click Exit and the device is immediately added to Xplorer’s Device Viewer.
In most cases, the device is automatically connected to Xplorer and is ready for use. If it 
is not connected (red box around the device), see Connecting a device to Xplorer, on 
page 13 for instructions on how to establish the connection.

Clip Template To take a clip to air in Xplay, the clip must be hosted in a template that 
contains a clip object. This setting specifies the template that is used to host 
clips.
This is an optional field when using Xplorer. If this device profile is used by 
another Vertigo Suite application in the future, you can always return to the 
Device Manager and edit to profile to include this setting.

Cel Template
&
Image 
Template

To take a Cel animation or image to air in Xplay, the asset must be hosted in a 
template that contains a cel animation or image object. This setting specifies 
the template that is used to host cel animation or image.
This is an optional field when using Xplorer. If this device profile is used by 
another Vertigo Suite application in the future, you can always return to the 
Device Manager and edit to profile to include this setting.

External Keyer Allows you to associate another device with the current device. This setting is 
used when the CG output is keyed over the output of an ImageStore device. 
This allows specific commands to be sent to the external keyer through the 
CG.
Note: The External Keyer setting is not displayed when FTP and HMP are 
selected as the device type.

Publish 
Master

When a publish master device is specified, all items that are published to the 
publish master are forwarded to the current device. This is a deprecated 
feature that has been kept for backward compatibility.
Note: The Publish Master setting is only displayed when Preview and Other 
are selected as the device type.
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Connecting a device to Xplorer
In addition to being present in the Device Viewer, devices must also be actively connected 
to Xplorer to ensure proper communication between the two. In most cases, a device’s 
connection to Xplorer is automatic and maintained if the device is properly configured and 
running on an active network. 

If for any reason, the connection between Xplorer and the device fails or is dropped, the 
Device Viewer alerts you of the failed connection by displaying a red box around the 
device. You can also see the connection status by hovering your cursor over the device 
(Online or Offline).

Common reasons for losing the connection are that the output device or the machine 
hosting Xplorer has lost its network connection (network is down, IP address has changed 
or network cable disconnected) or the output device has been shutdown or has stopped. 

To help you troubleshoot the connection failure, the Device Viewer contains the Ping 
Device menu command, which allows you to ping the device to verify the communication 
path between the device and Xplorer.

To ping a device:
1 Right-click the device in Xplorer’s Device Viewer.
2 Select the Ping Device command.

The Ping window appears.
3 Click the Ping button.

Xplorer attempts to ping the device and then displays its results.

If pinging the device results in a failure, open the Device Manager window and verify the 
device’s configuration settings. If the settings are correct, then continue troubleshooting by 
verifying that the device is operating and that its cabling connections are proper.

Once the connection is re-established, Xplorer will automatically update the Device Viewer, 
or you can right-click on a device and select the Reload Devices command.

The red box around the device
indicates that Xplorer is not
currently connected to the device.
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Launching a device’s Dashboard from Xplorer
Xplorer allows you to launch a device’s Dashboard, which contains the device’s 
configuration settings. Right-clicking a Vertigo XG, Intuition XG or Preview (Software CG) 
device in Xplorer’s Device view displays the Launch Dashboard command.

When the Launch Dashboard command is selected, the device’s XG Dashboard opens and 
searches for the device on the specified machine and port. If the device is found, then it is 
shown in the Dashboard’s device list and its properties are displayed for editing. In the case 
of Intuition XG devices, the port specified in the device definition is the automation port on 
Xplay rather than the port belonging to an XG instance. Because of this, all ports are 
scanned on Intuition XG devices. If multiple XG instances are running they will all be shown 
in the device list.

Only one instance of the XG Dashboard may be running at a time. If you attempt to open an 
XG Dashboard when another instance is already running, Xplorer display an error message.

A Dashboard launched from Xplorer only targets a specific machine and the port behaves 
slightly differently from a dashboard launched from the XG control panel. The Device 
Discovery settings are ignored and an automatic scan is performed on the requested 
device. The device list is not saved on exit regardless of the value of the Auto-Save Device 
List on Exit setting. The Load Device List and Save Device List commands/buttons are also 
disabled.
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Browsing and managing media on the XMS 
and other devices
As a media management application, Xplorer allows you to browse and manage the media 
content (assets) stored on the Xmedia Server, as well as the assets that have been published 
to and reside on other output devices. 

The following sections describe how to use Xplorer to access and browse the content of the 
Xmedia Server and other devices. Also described are some of the administrative tasks that 
you can perform to help organize and maintain the media set on the Xmedia Server and/or 
devices.

• Displaying the media contents of the XMS or a device, on page 16
• Browsing the contents of the XMS or a device, on page 17
• Searching for assets stored on the Xmedia Server, on page 19
• Categorizing within the Xmedia Server, on page 22
• Removing an asset from an XMS category or a device, on page 23
• Deleting assets from the Xmedia Server or a device, on page 24
• Renaming an asset, on page 25
• Viewing and editing an asset’s properties, on page 26
• Monitoring and managing a device’s disk space, on page 29
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Displaying the media contents of the XMS or a device
Despite being configured and connected to the Xmedia Server and several devices, Xplorer 
can only display the media content and work from the perspective of the Xmedia Server or 
one device at a time. As such, when you are working with Xplorer either the Xmedia Server 
(XMS) is selected or the selected device becomes Xplorer's active device.

The XMS icon and device icons in Xplorer’s Viewers act as buttons that you can click to 
determine whether to display and browse the contents of the Xmedia Server or a specific 
device. Once selected, an orange outline appears around the icon to identify that its 
content is currently being displayed in Xplorer.

When you select the XMS icon or a device’s icon, the Asset Browser immediately refreshes 
the categories and the assets are displayed in Xplorer’s Asset Browser and Asset Gallery. In 
addition to outlining the icon in the Viewers, the Asset Browser’s title bar also identifies the 
XMS or device.

Note: See page 17 for information and instructions on how to browse 
the content of the XMS and devices.
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Browsing the contents of the XMS or a device
When you select the XMS icon or a device’s icon in Xplorer’s Viewers, the categories and the 
assets displayed in Xplorer’s Asset Browser and Asset Gallery are immediately refreshed (see 
page 16). You can now browse the content by navigating through the hierarchical structure 
of root categories, subcategories and files. 

Most asset types can be displayed in the Asset Gallery either as thumbnail images using 
Proxy View, or as detailed lists using Detail View.

• Detail View lists the contents of the selected category/subcategory and provides 
detailed information about your assets, including name, format, author, description, 
and date modified. 

• Proxy view displays the contents of the selected category/subcategory as thumbnail 
images so you can quickly identify the individual assets.

Not all assets can be viewed in proxy mode. Since proxy view displays the assets using 
thumbnail images to preview the asset, the asset must have an image or visual component 
associated to it.

Asset types that can be viewed as Proxies include: 

Audio, Fonts, Scenes, Templates, Pages, Images, Cel Animations, Clips, Panels, Generic and 
Xmedia Objects

Asset types that cannot be viewed as Proxies include:

Jobs, Work Orders, Playlists, Rundowns, Segments, Scripts and Lookup Tables

To display the contents of the XMS or a device:
1 Select the Xmedia Server or device by clicking the XMS icon or device’s icon in the 

Viewers. 

Note: The size at which the thumbnail images are displayed can be 
edited using the Thumbnail Size setting (Tools>Settings>Layout). See 
Layout settings, on page 70 for more information.

Proxy View

Detail View
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Browsing the contents of the XMS or a device
Upon selecting the icon, the Asset Browser refreshes and displays the Asset categories 
for the XMS or the device.

2 Select the desired asset category icon and navigate through the subcategory folders by 
selecting the + symbol to expand the category, or select a subcategory.
The contents of the category are immediately displayed in the Asset Gallery.

3 Select either the Proxy View  or the Detail View  buttons from Xplorer’s 
toolbar to select the view format of the Asset Gallery. 

4 Repeat step 2 to browse through the contents of various asset types and categories.
5 To browse the contents of another device, repeat steps 1 to 4.

Note: If the desired device is not listed in the Device Viewer, or if the 
device is disconnected, see page 10 and page 13 for instructions on 
how to add, configure and connect a device to Xplorer.

Note: If you are not able to locate a particular asset or set of assets on 
the Xmedia Server by simply browsing through the Asset Browser and 
Asset Gallery, you can use Xplorer’s Search XMS feature to find it. See 
Searching for assets stored on the Xmedia Server, on page 19 for more 
information.
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Searching for assets stored on the Xmedia Server
Xplorer’s Search XMS text box allows you to quickly search for assets on the Xmedia Server 
using a typical search engine component. Once a search is launched, assets that match the 
name, type, description, author, keywords and/or Recall ID are returned in the XMS Search 
Results View and displayed in either a Proxy View or Detail View and ordered by relevance.

To search for assets stored on the Xmedia Server:
1 Ensure that the Xmedia Server is the active device by clicking the XMS icon in Xplorer’s 

Device Viewer (see page 16).
2 Type a search query in the Search XMS text box. 

See Search query syntax supported by the Search XMS below for descriptions and 
examples of the syntax you can use to build more effective search queries.

3 Optional: Limit Search XMS results to specific asset types. 
By default, all asset types are evaluated by the search query as indicated by the Type 
drop-down box set to All Types. 

• To limit the search results to one asset type, select an asset type from the Type 
drop-down list. 

• To limit the search results to multiple asset types, click the Browse  button to 
open the Select Types To Search dialog. Select the asset types that you want 
included in the search and uncheck the asset types that you want excluded from 
the search results.

4 Click the  button to launch the search.
If Xplorer was in the Category Browser View, launching a search switches to Xplorer to 
the XMS Search Results View.
Assets that satisfy the search query are displayed in the Results pane of the XMS Search 
Results View. 

5 Optional: Browse, sort and perform actions on the assets returned by the search.
• When the Proxy View button is selected in Xplorer’s toolbar, the assets appear as 

thumbnails in the Results pane in order of relevance to the search criteria. Right-
clicking the asset’s thumbnail displays a context menu of actions that can be 
performed on the asset.

• When the Detail View button is selected in Xplorer’s toolbar, the assets are listed in 
a table in the Results pane in order of relevance to the search criteria. Clicking the 
column headings allows you to sort the results based on that column. Right-

Note: The Search XMS window uses Solr, which a web-based solution 
by the Apache group that performs fast searches across large 
amounts of data. The Xmedia Server must maintain a connection to 
Solr so that it can create an index of the database. See the Xmedia 
Server Configuration Guide for more information.

Note: When the Search XMS text box has been restricted by asset type, 
the  button associated with the Search XMS text box changes color 
from gray to orange.
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Search query syntax supported by the Search XMS
clicking the asset’s row displays a context menu of actions that can be performed 
on the asset.

Search query syntax supported by the Search XMS
The search query syntax supported by the Search XMS text box is very similar to that 
supported by typical search engines. The following table provides descriptions and 
examples of syntax you can use to build more effective search queries.

Note: If an expected asset is not returned in the search results, it may 
be because user rights management is enabled on the Xmedia Server 
and the current user does not have permission to view the asset. See 
“User Rights Management” in the Xmedia Server Configuration Guide 
for more information.

Single term and 
wildcard characters

When a single term is specified in the search text box, any asset 
whose name, type, description, author, keywords and/or Recall ID 
matches the term is returned in the search results.
Wildcards are supported when using single terms, but not within 
multi-term phrases.
• To perform a single character wildcard search use the "?" symbol. For 

example, ca?e matches cake as well as cape.
• To perform a multiple character wildcard search use the "*" symbol. For 

example ap*, matches ape, apple, application, and apathetic.

Multiple terms When multiple terms are specified in the search text box, any asset 
whose name, type, description, author, keywords and/or Recall ID 
matches one or more of the terms is returned in the search result.

Multi-term phrase To search for a multi-term phrase, enclose the phrase in double 
quotes. Only results with an exact match to the terms and the 
order of the terms are returned. For example: “family 
vacation”
20



Xplorer
User Manual
Boolean operators Boolean operators allow terms to be combined in various ways. 
The following Boolean operators are supported:
Note that the Boolean operations must be in ALL CAPS.
• AND: The AND operator matches assets that contain both terms.  

Examples: House AND Fire or Fire + House
• +: The required operator is placed immediately before a term to indicate 

that the term must exist in the result.  
Example: +NASA weather 
Search results must contain NASA and may contain weather. If Assets 
that contain both terms receive a higher relevancy score that the assets 
with NASA only.

• OR: This is the default operator between terms if no operator is 
specified. The OR operator matches assets that contain either of the 
specified terms. Assets having both terms have a higher relevancy score. 
Example: House OR Residence

• NOT or -: The NOT ‘-‘ (hyphen character) operators exclude assets that 
contain the term after the operator.  
Example: House NOT Home or House -Home

Asset fields By default, basic search queries use the text entered to try to 
match against all of the following asset fields: name, asset type, 
description, author, keywords and Recall ID fields. It is possible to 
target specific asset fields in a search. 
Note that the searchable field names are all case sensitive and 
must include the colon : character.
The following field names can be used to restrict search results:
• name: Returns only matches to the terms specified in the asset’s name 

field.  
Example: name:”black box”

• description: Returns only matches to the terms specified in the asset’s 
description field.  
Example: description:weather

• asset_type: Returns only matches to the specified asset type.  
Example: asset_type:clip

• author: Returns only matches to the asset’s author field.  
Example: author:jsmith

• recall_id: Returns only valid Recall IDs. An asset is considered to have a 
valid Recall ID if the recall is not blank and not equal to 0.  
Example: recall_id:['' TO *] AND -recall_id:0
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Categorizing within the Xmedia Server
An asset may be placed in one or more categories in the Xmedia Server. You can change the 
set of categories where the asset resides using the Categorize command.

To move or add an asset to another category within the same Xmedia Server device:
1 Select the XMS device from the Device Viewer.
2 Select the root category in the Asset Browser and navigate to the asset that is to be 

moved or added to another category.
3 Right-click on the asset in the Asset Gallery and select the Categorize command.

The Recategorize window appears, which displays the current location(s) of the asset, 
as well as all of the possible categories where the asset can reside.

4 Select the category, or multiple categories, where you want the asset to be located. 
Note that you can remove the asset from its current category by deselecting the 
category (see note below). 

5 Click OK and the asset is immediately moved to the specified categories.

Note: While assets can be recategorized within the Xmedia Server, you 
cannot use Xplorer to recategorize assets directly from within the 
device.

Note: You are not permitted to deselect all categories before 
committing to this change otherwise the asset might be orphaned it 
would not have an assigned category to reside in and therefore be 
invisible to the Asset Browser.
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Removing an asset from an XMS category or a device
Managing the assets on the Xmedia Server and associated devices often involves 
eliminating redundant instances of a asset. However, you probably do not want to delete 
the asset completely from the system. As such, the following sections describe how to 
remove duplicate assets from Xmedia Server categories, as well as how to remove 
published assets from associated devices, without deleting the asset from the Xmedia 
Server.

• Removing an asset from a category on the Xmedia Server, on page 23
• Removing assets from devices, but not the Xmedia Server, on page 23

Removing an asset from a category on the Xmedia Server
When an asset is stored in more than one category on the Xmedia Server, the Remove 
From Category command becomes available in the Asset Gallery’s context menu. This 
command allows you to remove the selected asset from the category on the Xmedia Server, 
as well as other devices, without deleting the asset entirely from the Xmedia Server or from 
the other categories.

To remove an asset from a category on the Xmedia Server (and other devices):
1 Select the XMS in the Device Viewer.
2 Select the asset category’s icon in the Asset Browser and navigate to the subcategory 

that contains the asset.
3 In the Asset Gallery, right-click on the asset that is to be removed and select the 

Remove From Category command.
4 The Remove Asset window appears and asks you to confirm your intention to remove 

the asset.
5 Click OK and the asset is immediately removed from the category on the Xmedia Server 

and all other devices that held this asset in that category.

Removing assets from devices, but not the Xmedia Server
When published assets are no longer required on a device, you may want to remove them 
from the device, but leave a copy of the assets on the Xmedia Server as an archive. In such a 
case, the Remove from Device command allows you to either remove an entire category of 
assets, or selected assets, from specified devices.

To remove assets from specific devices, without removing them from the Xmedia Server 
or deleting the asset:

1 Select the device from the Device Viewer that contains the asset that you want to 
remove.

2 Select the Asset Category icon in the Asset Browser and navigate to the subcategory 
that contains the asset.

3 In the Asset Gallery, select the asset, or multiple assets, that are to be removed from the 
device.

Note: Use the Delete command to delete the asset completely from 
the Xmedia Server or the device. See page 24 for more information.
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4 To select multiple assets, press the SHIFT key as you click on each asset for consecutive 
selections, or press the CTRL key to select a grouping of non-consecutive files.

5 Right-click on one of the selected assets and select the Remove From Device 
command.

6 Click OK when prompted to confirm the removal of the assets.
The assets are immediately removed from the category on the device, but they remain 
untouched on the Xmedia Server and other devices.

Deleting assets from the Xmedia Server or a device
Deleting an asset refers to permanently removing the asset from the system with no means 
for retrieving the asset afterwards. You would most likely want to delete assets that are 
unnecessary or outdated and will not be used in the future. 

The following instructions describe how to properly remove assets from the Xmedia Server 
or another device.

To delete assets from the Xmedia Server or a device:
1 Select the XMS icon or a device icon from the Viewers.
2 Select the root category in the Asset Browser and navigate through the categories until 

the assets that are to be deleted from the system appear in the Asset Gallery.
3 Select a single asset or select multiple files by press the SHIFT key as you click on each 

asset for consecutive selections, or press the CTRL key to select a grouping of non-
consecutive files.

4 Right-click on one of the selected assets and select the Delete from XMS command.
The Delete Asset window appears (Figure 3-1) and asks you to confirm that you 
intentionally want to delete the selected assets. Note that when deleting a single asset, 
the Delete Asset window specifies the file’s name and the device’s name, while the 
Delete Asset window that appears for multiple assets is not asset-specific.

Fig. 3-1: The Delete Asset window asks for confirmation before deleting the asset(s)

5 Click OK to permanently delete the asset(s), or Cancel to leave the asset(s) unchanged 
in the system.

Note: You can also remove assets or an asset category from a single or 
all associated devices by selecting the XMS icon and navigating to the 
category or assets. Select the category or assets to be removed and 
then right-click on the category/assets. Select the Remove From 
command. Select either the single device or All Associated Devices. 
The Publish Remove window appears and the assets are immediately 
removed from the category on the device, but they remain 
untouched on the Xmedia Server.
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Renaming an asset
Xplorer allows you to rename assets. Changes to the asset’s name are applied to all 
instances of the asset, whether the asset is renamed from the Xmedia Server or from a 
device.

To rename an asset:
1 Right-click on the asset in the Asset Gallery and select the Rename On XMS command.

The Rename Asset window appears.

2 Type the asset’s new name in the text box and click OK. The asset’s name is immediately 
changed on the Xmedia Server and the devices where the asset has been published. 
There is no need to republish the asset.
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Viewing and editing an asset’s properties
The Asset Gallery’s Properties command allows you to display an asset’s complete 
properties in the Asset Properties window (Figure ).

To display an asset’s properties:
1 Open the Asset Properties window for the asset. 

With the asset displayed in the Asset Gallery, right-click on the asset and select the 
Properties command.
The Asset Properties window appears.

2 Verify the identity of the asset by:
• If the asset has a proxy image, it will be displayed in the thumbnail display on the 

Asset Properties window. If the asset does not have a proxy image, then a generic 
Proxy Not Available icon is displayed.

• Verify the Name property’s setting in the Properties list.
• Click the Preview button. If the asset is able to be previewed it will be displayed in a 

separate window (see Previewing assets in Xplorer, on page 53 for more 
information).

Note: When Xplorer is in Detail View mode, some of the assets’ 
properties are conveniently displayed in the Asset Gallery. See 
page 17 for more information.

Asset’s thumbnail

Sorting buttons

Asset’s properties

Selected property description

Preview, Advanced, Save, & Cancel buttons
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3 View and edit the asset’s property settings:
• All of the asset’s properties and its current settings are listed on the Asset 

Properties window. Selecting a property’s heading (left column) displays a short 
description of that property below the property list.

• Not all property settings can be edited. In fact, most are read-only. Only those 
settings that are bold and some empty fields can be edited by clicking in the field 
and typing the new setting value.  
Selecting the Keywords property’s setting box produces a  button. When 
selected, this button opens a Keyword Editor window for entering keywords. 
Similarly, selecting the Expiry Date property’s setting box also produces a  
button. When selected, this button opens a Expiry Date Editor window for setting 
the expiry date using a calendar tool.

• The asset’s properties can be listed in two different formats using the sorting 
buttons. Select the Categorized  button to view the properties listed in 
thematic groupings, or the Alphabetical  button to list the properties 
alphabetically. 

4 Save or close the Asset Properties window. If you have made any edits to the property 
settings, you must click Save for the changes to become permanent. If you want to 
close the window without saving any edits or changes, click Cancel and the window 
closes immediately.

Note: Click the Advanced button to view the advanced properties for 
image assets. See Displaying an image asset’s advanced properties, 
on page 28 for more information.
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Displaying an image asset’s advanced properties
In addition to the standard properties that are displayed in the Asset Properties window, 
image assets can also contain meta data property settings, which can be viewed and set 
using the Image Properties window. 

To open the Image Properties window, select the Advanced button that is located in the 
lower-left corner of the Asset Properties window (see figure <Active> on page 3-26). 

The Image Properties window contains seven (7) thematic tabs, each features properties 
and settings that apply to the image asset. 

Once you have edited the settings, click OK to save and apply the new settings. Otherwise, 
click Cancel to apply no chances and close the window.
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Monitoring and managing a device’s disk space
As a media management application, Xplorer provides several features and techniques for 
monitoring and managing the available disk space on the Xmedia Server and other devices.

It is important to monitor how much free disk space is left on a device to allow you to free 
up space if needed.

When the View>Show Device Details menu command is enable, Device Details are 
displayed below the icons in the Device Viewer. The Freespace property displays the 
percentage of disk space that is still available on the device. Alternatively, you can hover the 
cursor over the device’s icon to display updated device details.

A device’s precise disk space levels can be viewed by right-clicking the device’s icon in the 
Device Viewer and selecting the Properties command. The Device Properties window 
appears and provides the exact amount of Free Disk Space and Used Disk Space for the 
device’s C drive.

To avoid running low on disk space, it is important that you manage the contents of the 
Xmedia Server and devices by removing unnecessary, duplicate, or outdated content files. 

Manual techniques for removing and deleting assets from the Xmedia Server and/or 
devices are described in the following sections:

• Removing an asset from an XMS category or a device, on page 23
• Deleting assets from the Xmedia Server or a device, on page 24

Another method for eliminating unnecessary assets is to set the asset’s Expiry Date and/or 
Publish Lifespan properties.

Note: When Xplorer’s Device View toolbar button  is enabled, the 
Device Viewer expands to full screen and the Device Details 
information is automatically enabled below each device’s icon.
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You can access an asset’s properties by right-clicking on the asset in the Asset Gallery and 
select the Properties command.

Expiry Date Determines when the asset is automatically deleted from the 
Xmedia Server and devices.
When set to None, the asset will remain on the Xmedia Server 
and publish devices until it is manually removed or deleted.
You can also select this property and click the  button, which 
opens the Expiry Date Editor window. Use this window to set 
the date upon which the asset will automatically be deleted from 
the Xmedia Server and devices.
Click Save in the Properties window to apply any changes.

Publish Lifespan When the publish lifespan expires, the asset is removed from the 
device but remains in the Xmedia Server.

Expiry Date

Publish Lifespan
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devices
As a media management application, Xplorer offers you different ways of moving assets to, 
from, and within the Xmedia Server and other devices. Which method you use for moving 
assets around depends upon the type or source of the asset and its destination.

The following sections describe and provide instructions for moving and managing the 
assets on the Xmedia Server (XMS) and other configured devices:

• Managed versus unmanaged assets, on page 32
• Ingesting third-party content files, on page 33
• Importing content files that are native to the Vertigo Suite system, on page 41
• Publishing assets from the Xmedia Server to a device, on page 42
• Publishing the entire contents of one device to another device, on page 48
• Propagating assets from the Xmedia Server to another server, on page 49
• Exporting Vertigo asset files to another Xmedia Server, on page 50
• Saving a local copy of an asset as a file, on page 52

Note: Information and instructions for managing assets within the 
Xmedia Server (i.e. recategorizing, deleting and renaming assets) are 
provided in sections starting on page 31.
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Managed versus unmanaged assets
At the center of the Vertigo Suite’s architecture is the Xmedia Server (XMS), which acts as a 
central archive of the assets available on your system. Xplorer is the application that not 
only allows you to manage the assets on the Xmedia Server, but also helps you to publish 
assets to and access assets that reside on other processors like a Vertigo XG, Intuition XG, 
ImageStore, or Intuition.

When discussing asset management involving the Xmedia Server and other devices, we 
must distinguish between managed assets and unmanaged assets. A managed asset is an 
asset which has been ingested into the Xmedia Server. The Xmedia Server manages the 
asset and it is responsible for the various tasks that are performed on or with the asset like, 
publishing, deleting, renaming... etc. 

An unmanaged asset is an asset which resides on a device, which has not been ingested 
into the XMS and therefore the XMS does not know about it. For example, the first time you 
browse an Intuition or Imagestore using Xplorer, the Xmedia Server retrieves a list of all the 
assets on the device using the device’s publish history. If an asset resides on the Intuition or 
Imagestore, but was not published there by the Xmedia Server (i.e. not in the publish 
history), it is considered unmanaged. In such a case, the asset was not ingested into Xmedia 
Server, but it was published to the Intuition or Imagestore by some other means. Similarly, 
unmanaged assets can also exist on a VertigoXG if they were ingested directly into the 
EXMS.

Identifying managed and unmanaged assets
A device can contain both managed and unmanaged assets. Identifying whether an asset is 
managed or unmanaged in Xplorer is easy. In Detail view, the colored square beside the 
asset name is light blue if the asset is managed and dark blue if the asset is unmanaged. In 
Proxy View, managed assets are identified by the asset’s light blue tile background/border 
color, while an unmanaged asset displays a dark blue tile color.

A valid technique for adding an individual asset or the entire contents of a category is by 
dragging it from one device’s Asset Browser/Gallery and dropping it on a device in the 
Device Viewer. If the asset is managed, it will be published immediately to the recipient 
device. If, however, the asset is unmanaged and it is dragged to an Imagestore or Intuition 
device, the file will be copied over. While dragging an unmanaged asset onto a Vertigo XG 
or Intuition XG device launches the Categorize window allowing you to select the 
categories in which the asset will reside.

Note: An unmanaged asset can be made into a managed asset by 
dragging the asset from the Asset Gallery onto the XMS icon in 
Xplorer’s Device Viewer.

Managed asset (light blue) Unmanaged asset (dark blue)
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Ingesting third-party content files
Individual content files (i.e. images, cel animations, video clips, and audio clips) that make 
up broadcast graphics are normally produced by third-party applications outside of the 
Vertigo Suite. Therefore, you must ingest them into the Xmedia Server before they can be 
used by the Vertigo applications as assets. Ingesting a file basically means converting the 
file into a Vertigo asset and saving it on the Xmedia Server according to its asset type.

While the procedure for ingesting image, video, and audio files is for the most part the 
same, ingesting cel animations requires a different procedure. The following sections 
provide information and instructions for ingesting files into the system.

• Ingesting image or audio files, on page 33
• Ingesting image sequences, on page 35
• Ingesting video files, on page 39

Ingesting image or audio files
Images and audio clips that were created using third-party applications must be ingested 
into the Xmedia Server before they can be used by the Vertigo Suite applications. 

To ingest an image or audio file:
1 Click the Ingest button  in Xplorer’s toolbar or select the File>Ingest menu 

command.
The Ingest Files window appears.

2 Navigate through the categories in the Ingest Files window and select the file(s) that 
are to be ingested into the Xmedia Server.
You can ingest multiple files by pressing the SHIFT key as you click on each file for 
consecutive selections, or pressing the CTRL key to select a grouping of non-
consecutive files.

3 Click Open.

Note: If you are ingesting multiple image files that have a sequential 
naming convention and/or ingesting image files for purposes of 
creating a cel animation or video clip, please refer to Ingesting image 
sequences, on page 35. 
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The New Media window appears, which allows you to specify and save details about 
the ingested asset file.

4 Selecting a file’s name in the New Media List displays the file’s information and all of 
the categories within the appropriate root category. When an image file is being 
ingested, a proxy of the image is displayed in the center pane of the Ingest window. If 
an audio file is being ingested, then the Ingest window features the Windows Media 
Player allowing you to preview the playout of the audio clip before ingesting it.

5 Select the first file name in the New Media List panel and complete the following tasks. 
Repeat this step for each file listed in the New Media List panel.

a In the Name field, assign a name to the asset to be called. By default, the file’s name 
is used. 
If you are ingesting an edited version of a file that already exists on the Xmedia 
Server, saving it under the same name in the same category overwrites the 
previous version of the asset. To avoid overwriting the asset, rename it or save it to 
another category.

b Optional - Enter your name in the Author field.
c Optional - Enter a short description in the Description field.
d Optional - Enable and set a Expiry Date and Publish Lifespan fields. The Expiry 

Date specifies a date when the asset will be automatically deleted from the main 
XMS, spoke XMSs (hub & spoke model), as well as removing the asset from the 
devices that it was published to.  
The Publish Lifespan is used by the Xmedia Server to determine how long (in days) 
the asset remains on a device that it has been published to before it is removed.

e The Manage asset from its current location check box will only be enabled if the 
asset that is to be ingested is currently stored on an external device which is 
accessible by the Xmedia Server. 
Selecting this option can save space on the Xmedia Server by managing the asset 

Note: If the first three letters in the name of the selected image file are 
identical to other files in the same directory (i.e. Bug001, Bug002, 
Bug003...), the Ingesting a Cel Animation message box appears and 
asks if your intention is to ingest the single image file or to create cel 
animation. 
• Select No to ingest a single image file using the New Media window.
• Select Yes to create a cel animation from the set of identically named image files 

using the Multi-image Ingest window. See page 35 for instructions on how to 
proceed in such a case.

Displaying the proxy of the image file Media Player for previewing the audio file
34



Xplorer
User Manual
from its current location instead of making a copy. In most cases, this parameter 
should not be enabled.

f Assign the asset to one or more categories by selecting check boxes in the 
Categories box. To create a new category, right-click in the Categories box and 
select Add Category from the pop-up menu.

g Optional - Assign the file one or more keywords by selecting check boxes in the 
Keywords box. (Keywords are used by Xplorer’s Search XMS feature for searching 
and retrieving assets.) To create a new keyword, right-click in the Keywords box 
and select Add Keyword from the pop-up menu.

6 Click OK to save and exit the Ingest window.
Or,
Click Cancel to discard the new information entered in the window, exit and return to 
Xplorer.

Ingesting image sequences
As explained on page 33, you can use Xplorer to ingest a single image file. Additionally, you 
can use Xplorer’s Multi-image Ingest window to ingest multiple image files or create a cel 
animation or clip from a series of sequentially named images files.

To ingest multiple images or convert the image files into a cel animation or a clip 
animation:

1 Click the Ingest button  in Xplorer’s toolbar or select the File>Ingest menu 
command.
The Ingest Files window appears.

2 Navigate through the categories in the Ingest Files window and select the image file(s) 
that are to be ingested. Then click Open. 

If you selected a single image file and the first three letters in the name of the file are 
identical to other files in the same directory (i.e. Bug001, Bug002, Bug003...), the 
Ingesting a Cel Animation message box appears and asks if your intention is to ingest 
the single image file or to create cel animation. 

• Select No to ingest the single image file using the Ingest window. See page 33 for 
instructions on how to proceed in such a case. 

Note: You select multiple files by pressing the SHIFT key as you click 
on each file for consecutive selections, or pressing the CTRL key to 
select a grouping of non-consecutive files.
35



Moving assets to/from the XMS and other devices
Ingesting image sequences
• Select Yes to create a cel animation or clip from the set of identically named image 
files using the Multi-image Ingest window. 

If however, you selected multiple image files, the Multi-image Ingest window 
automatically appears and offers you several options to either ingest the individual 
image files, or to create a cel animation or clip asset from these image files.

3 When the Multi-image Ingest window appears, it offers you six (6) options for how you 
can proceed to ingest the set of image files. Each option is described in the table below. 

4 When the Multi-image Ingest dialog box appears, it offers you five options for how you 
can proceed to ingest the set of image files. Each option and its settings are described 
in the table below. 
Note that the Xplorer takes into consideration what is trying to be ingested and makes 
a preliminary suggestion as to which option to use by pre-selecting an option for you. 
You may use the pre-selected option or select another.

VAF The VAF option ingests the selected image files and converts 
their sequential playout into a video clip asset. The resulting 
video clip asset is saved using the Vertigo Animation Format 
(.vaf ) and it is stored in the Xmedia Server’s Clips category.
This option is recommended for large animations. 
Note that this option does not preserve the original format and it 
offers a reduction in looping options.

• Frame Rate: Select the frame rate of the video clip asset. 
Valid settings are: 25, 30M, 30, 50, 60M and 60.

OXI +VAF Select the OXI +VAF option when ingesting large animations. In 
such a case, the OXI is the master, while the VAF as the alternate 
format. 
When publishing the OXI + VAF, the Xmedia Server determines 
whether to publish the OXI or the VAF based on the target device 
type. Note that this option results in a reduction of looping 
options, but there is no size limit for the VAF file.

• Format: Select the target video format of the cel 
animation. This information indicates the desired full 
screen size and is used when the cel animation is cropped. 
Valid settings are: PAL, NTSC, 720p60, 720p60M, 720p50, 
1080i30, 1080i30M, and 1080i25
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OXI The OXI option ingests the multiple images and creates a cel 
animation by converting the images into oxi format, which is a 
series of targa format files (.tga) that are lossless, uncompressed, 
and cropped. The resulting .oxi file will be saved as a cel 
animation asset in the Cel Animation category.
The OXI option is recommended when ingesting smaller 
animations. Unlike the OXI +VAF option, the OXI option provides 
additional looping options. The recommended file sizes for this 
option are < 250 MB when the target device is a Vertigo XG and < 
4 GB when the target device is an Intuition.

• Format: Select the target video format of the cel 
animation. This information indicates the desired full 
screen size and is used when the cel animation is cropped. 
Valid settings are: PAL, NTSC, 720p60, 720p60M, 720p50, 
1080i30, 1080i30M, and 1080i25

• Interlaced: Enable this setting if the images that make up 
the sequence being ingested contain fields, rather than 
frames. Disable this setting if the images that make up the 
sequence contain frames. 

• Use Original Size: Enable this setting if the width and 
height of the cel animation will be equal to the width and 
height of the images from which it was created. When this 
setting is disabled, the cel animation will be cropped to 
the smallest size possible.

• Reverse: The reverse parameter determines whether the 
files that make up the sequence should be played in 
reverse order: True or False (default).

J2K+OXI The J2K+OXI option is used with HMP devices. In such a case, the 
J2K is the master, while the OXI as the alternate format. 
Click the Advanced button to expose the following settings:

• AutoPlay
• End Clip Behaviour: Select the behavior of the clip when 

it reaches the end: Output black, Hold last frame or 
Cue first frame

• Fade in (frames): Specify the number of frames for fade in.
• Fade out (frames): Specify the number of frames for fade 

out.
• V joint (frames): Specify the number of frames for V-Joint.
• Hold first (frames): Specify the time in number of frames 

to hold on the first frame of data.
• Hold Last (frames): Specify the time in number of frames 

to hold on the last frame of data.

Ingest multiple images The Ingest multiple images option ingests several images and 
saves them as individual image files in the Xmedia Server’s 
Image category.
There are no settings associated with this option.
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5 Set the Looping properties. 
Figure 4-1 shows the looping properties that are available when different ingest 
options are selected.

Fig. 4-1: The Loop parameter formats for multi-image ingest options

• Loop - While the check box can be enabled or disabled, the Loop drop-down list has 
three (3) possible settings:

• True: Enables looping. When this setting is used the animation will loop until an 
action is sent to stop it.

• False: Disables looping.
• Unspecified: Takes the looping setting that is already established by the scene 

object.
When looping is enabled, the Start Loop and End Loop settings specify the range of 
frames over which looping occurs. In general, the animation plays all frames up to and 
including the frame specified by the End Loop frame, then jumps back to the Start 
Loop frame and plays again up to the End Loop frame repeatedly until looping is 
disabled. At this point the animation plays the frame after the End Loop frame. 
The Loop setting is used in conjunction with Start Loop and End Loop settings. If Start 
Loop and End Loop are set to -1, then the entire cel animation loops continuously. If 
either Start Loop or End Loop is not -1, then the cel animation does a four point loop 
(in-loop-out). If Loop is disabled, the cel animation plays once from beginning to end. 
However, if loop is disabled and Start Loop and End Loop are both set to the same 
value (other than -1), then the cel animation displays the frame specified by Start Loop 
and End Loop and the cel animation can be controlled by automation. Note that if Ping 
Pong is enabled, and both Start Loop and End Loop are set to -1, then Loop is ignored. 

• Ping Pong - If enabled, and both Start Loop and End Loop settings are set to -1, then 
the cel animation plays in ping-pong mode. That is, it plays from beginning to end and 
then back to the beginning.

• Start Frame - Specify the frame at which the cel animation starts playout.  
A value of -1 means start at the beginning.

• End Frame - Specify the frame at which the cel animation ends playout.  
A value of -1 means play until the end.

• Start Loop - Specify the frame at which looping starts.  
A value of -1 means loop from the beginning of the cel animation.

VAF, OXI + VAF, OXI with embedded VAFOXI J2K + OXI
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• End Loop - Specify the frame where the cel animation loop ends.  
A value of -1 means loop until the end of the cel animation. 

6 Click OK and the Ingest window appears.
7 Optional - You can preview the cel animation or clip by dragging the slider or using the 

arrow buttons along the bottom of the preview display in the middle panel. When you 
are ingesting multiple images, you can preview an image file by selecting its file name 
in the New Media List. 

8 Choose the proxy by selecting a frame in the preview window.
9 Assign a name to the asset in the Name field. By default, the file’s name is used.

Note: If you are ingesting an edited version of a file that already exists on the selected 
device, saving it under the same name in the same category overwrites the previous 
version of the asset. To avoid overwriting the asset, rename it or save it to another 
category.

10 Optional - Enter your name in the Author field.
11 Optional - Enter a short description in the Description field.
12 Optional - Enable and set a Expiry Date and Publish Lifespan fields. The Expiry Date 

specifies a date when the asset will be automatically deleted from the main XMS, spoke 
XMSs (hub & spoke model), as well as removing the asset from the devices that it was 
published to.  
The Publish Lifespan is used by the Xmedia Server to determine how long (in days) the 
asset remains on a device that it has been published to before it is removed.

13 The Manage asset from its current location check box will only be enabled if the asset 
that is to be ingested is currently stored on an external device and if the permission 
permit access. If this criteria is met, the parameter is available and you can save space 
on your local/central XMS by managing the asset from its current location. In most 
cases, this parameter should not be enabled.

14 Assign the asset to one or more categories by selecting check boxes in the Categories 
box. To create a new category, right-click in the Categories box and select Add 
Category from the pop-up menu. 

15 Optional - Assign the file one or more keywords by selecting check boxes in the 
Keywords box. (Keywords are used by the Search XMS feature for searching and 
retrieving assets.) To create a new keyword, right-click in the Keywords box and select 
Add Keyword from the pop-up menu.

16 Click OK to save and exit the Ingest window.
Or,
Click Cancel to discard the new information entered in the window and return to 
Xplorer.

Ingesting video files
Video clips that are created using third-party applications must be ingested into the 
Xmedia Server before they can be used by the Vertigo Suite applications.

Note: All frames are specified starting from 0 for the first frame in the 
cel animation.
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To ingest a video clip:
1 Click the Ingest button  in Xplorer’s toolbar or select the File>Ingest menu 

command.
The Ingest Files window appears.

2 Navigate through the categories in the Ingest Files window and select the file(s) that 
are to be ingested. Then click Open. 
To select multiple files, press the SHIFT key as you click on each asset for consecutive 
selections, or press the CTRL key to select a grouping of non-consecutive files. 

3 When the Ingest window appears, select the first file name in the New Media List panel 
and complete the following tasks. Repeat this step for each file listed in the New Media 
List panel.

a Optional - Preview the clip in the Windows Media Player in the middle panel to 
confirm that this is the correct video file to be ingested.

b Optional - Select a proxy by moving the slider in the Windows Media Player to the 
desired frame. Optionally, you can use the Proxy Mode button to choose a jpg file.

c In the Name field, assign a name to the asset. By default, the file’s name is used. 
Note: If you are ingesting an edited version of a file that already exists on the 
selected device, saving it under the same name in the same category overwrites 
the previous version of the asset. To avoid overwriting the asset, rename it or save it 
to another category.

d Enter your name in the Author field.
e Optional - Enter a short description in the Description field.
f Optional - Enable and set a Expiry Date and Publish Lifespan fields. The Expiry 

Date specifies a date when the asset will be automatically deleted from the main 
XMS, spoke XMSs (hub & spoke model), as well as removing the asset from the 
devices that it was published to.  
The Publish Lifespan is used by the Xmedia Server to determine how long (in days) 
the asset remains on a device that it has been published to before it is removed.

g The Manage asset from its current location check box will only be enabled if the 
asset that is to be ingested is currently stored on an external device and if the 
permission permit access. If this criteria is met, the parameter is available and you 
can save space on your local/central XMS by managing the asset from its current 
location. In most cases, this parameter should not be enabled.

h Assign the asset to one or more categories by selecting check boxes in the 
Categories box. To create a new category, right-click in the Categories box and 
select Add Category from the pop-up menu.

i Optional - Assign the file one or more keywords by selecting check boxes in the 
Keywords box. (Keywords are used by Xplorer’s Search XMS feature for searching 
and retrieving assets.) To create a new keyword, right-click in the Keywords box 
and select Add Keyword from the pop-up menu.

4 Click OK to save and exit the Ingest window.
Or,
Click Cancel to discard the new information entered and return to Xplorer.
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Importing content files that are native to the Vertigo Suite system
If you would like to add and use Vertigo assets that were created on a separate Vertigo Suite 
installation (e.g. stored on a different Xmedia Server), the assets must first be exported from 
the original system (see page 50), which creates a folder containing the exported assets 
along with a Vertigo Export file (.exp). 

You can then use Xplorer (or Xstudio) to import the .exp file into your Xmedia Server. Unlike 
ingesting files, which loads and converts files from third-party formats into Vertigo assets, 
imported assets are already in the appropriate Vertigo formats and therefore require no 
conversion. The assets are also automatically assigned to their rightful place on the Xmedia 
Server according to their asset type and previous categorization.

There are two things to worth noting regarding importing asset files:
• Links to data will not be maintained. The same data sources need to be set up on 

your server and the links re-established.
• Existing assets may be overwritten. This only occurs under a very specific set of 

circumstances. For example, if you import a file in a category that has the same name as 
a file in an identically named category, the imported file will overwrite the other one. 
Also, if you import a file from the root category and an identically named file is in the 
root category of the installation you are importing to, the imported file will overwrite 
the other one. You can prevent files from being overwritten by assigning them to 
different categories, since an imported file will only overwrite another file if both have 
the same name and belong to the root category or to an identically named category.

To import assets:
1 Select the Import button  from Xplorer’s toolbar.

The Select VertigoXmedia Asset Export File window appears.
2 Navigate to the export folder that contains the asset(s) that you want to import  

(i.e. VxM_Export_21082008_125200).
3 Double-click the folder to display its contents.
4 Select the .exp file and then click the Open button. 
5 The Import window appears and identifies all of the assets that will be imported from 

the export file to the target XMS. An icon in front of the asset’s name indicates whether 
the asset is being added  or is being updated . 
The assets are displayed in a tree-structure that represents the assets’ destination 
among the target server’s categories. Newly created categories are indicated the  
icon.

Note: If the assets that you are importing contain data schemas, then 
your data schema connection settings will likely need to be changed. 
Do this before using any templates, scenes, or pages.
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Fig. 4-2: The Import window provides a verification step before the import operation is performed

Figure 4-2 also demonstrates that the Import window can also contain a list of error or 
warning messages to alert users of problems that may occur if the import is performed. 
For example, some categories may have to be renamed and some assets will not be 
able to be categorized because of name conflicts. Clicking on an asset that shows 
either an error or warning icon highlights the associated messages. Similarly, clicking 
on a message will select the corresponding asset or category in the tree. 

6 After inspecting the import contents, select the Import button to proceed with the 
import or select Cancel to abort the import. 
The Import window remains open after Import is clicked so that it can be referenced 
when looking for newly imported assets. Select the Close button to close the Import 
window.

7 Optional: Verify that the asset was properly imported by opening the Asset Browser 
and navigating to the category where you expected the asset to be stored.

Publishing assets from the Xmedia Server to a device
In the Vertigo workflow, assets are centrally stored on the Xmedia Server. Before an asset 
can be used on an output device, a copy of the asset must be transferred from the Xmedia 
Server and stored locally on the device. This transfer process is referred to as publishing the 
asset.

When you publish assets to a device, the Publish Progress window keeps track of which 
assets have been recently published and the status of the publishing process. You can also 
use the Publish Queue Monitor to monitor and manage a device’s publish queue.

Note: Transferring assets by exporting assets from one XMS and then 
importing them into another XMS manually is ideal for low volume 
and infrequent transfers. However, if you are frequently transferring 
assets between servers, we recommend using propagation to transfer 
assets. See Propagating assets from the Xmedia Server to another 
server, on page 49 for more information.
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There are two (2) ways in which assets can be published to a device: 
• Automatically publishing assets to devices, on page 43
• Manually publishing assets from the Xmedia Server to devices, on page 43

Automatically publishing assets to devices
You can set up Xplorer so that when you ingest or import an asset into the Xmedia Server, 
the asset is automatically published to preselected devices.

To set up Xplorer for automatic publishing assets to devices:
1 Prior to ingesting or importing the asset(s) into the Xmedia Server, open Xplorer and 

verify that the XMS and the devices are present and actively connected in the Device 
Viewer. If not, see page 10 and page 13 for instructions on how to add and/or connect 
devices.

2 Select the XMS icon in the Xmedia Server Viewer.
3 Select the Asset Category’s icon in the Asset Browser and navigate to the category 

where the asset(s) will be ingested or imported into.
4 Right-click on the category and select the Properties command.  

The Publish Devices window appears.
5 Select the devices that you want to publish the asset to when it is received by the XMS.
6 Click OK.

From this point on, every time an asset is added to the specific category on the Xmedia 
Server, the asset will be automatically published to the selected devices.

To deactivate the automatic publishing of a category:
1 Select the XMS icon in the Xmedia Server Viewer.
2 Right-click on the category and select the Remove From command, as well as the 

device(s) from which they are to be removed.
The Publish Remove window appears and lists the assets that are being deleted from 
the device. Once finished close the Publish Remove window.

3 Right-click on the category once again and select the Properties command from the 
context menu. The Category Properties dialog box appears. 

4 Disable the check boxes next to the devices that you no longer want to automatically 
publish to.

5 Click OK.

Manually publishing assets from the Xmedia Server to devices
Using Xplorer, you can manually publish assets from the Xmedia Server to specific devices 
in preparation for playout on those devices. 

Note: Re-enabling autopublish does not trigger a publish. To force a 
publish, you must manually publish using the Publish To command 
(see page 43).
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The quickest way to publish an asset from the Xmedia Server to a device is to drag the asset 
or its category from the Xplorer’s Asset Gallery and drop it onto the device in the Device 
Viewer.

Fig. 4-3: A quick way to publish an asset to a device is to drag & drop from the Asset Gallery

The following instructions describe an alternative way of manually publishing asset using 
the Publish commands.

To publish manually assets from the Xmedia Server to one or several devices:
1 Launch Xplorer and verify that the Xmedia Server and the devices are present and 

actively connected in the Xplorer Viewers. If not, see page 10 and page 13 for 
instructions on how to add and/or connect devices.

2 Select the View>Publish Progress command to open the Publish Progress window. 
The Publish Progress window allows you to track all of the assets that have been 
published during the current Xplorer session.

3 Select the XMS icon in the Xmedia Server Viewer. 
The contents of the Xmedia Server appears in the Asset Browser and Asset Gallery.

4 Select the appropriate asset category icon and navigate to the category folder that 
contains the asset(s) that are to be published.

5 Determine if you want to publish the asset(s) to one or more devices. If you want to 
publish to just one device, then continue to the next step. 
If you want to publish the asset(s) to more than one device:

a Right-click on the category and select the Properties command. 
The Publish Devices window appears.

b Enable the devices that will receive the published asset(s).
c Click OK.

6 In the Asset Gallery, select the asset(s) you want to publish:
• If you want to publish all of the assets contained in a category, right-click on the 

category in the Asset Browser and a context menu appears.
• If you want to publish just one of the assets in a category, right-click on the asset in 

the Asset Gallery, and a context menu appears.
• If you want to publish several assets displayed in the Asset Gallery, hold down the 

Ctrl key and select the desired assets. Release the Ctrl key and right-click on one of 
the selected assets in the Asset Gallery. A context menu appears.

7 Select either the Publish To command or the Force Publish To command.
The Publish command is the most efficient choice, since it only publishes assets which 
have not previously been published or have changed since last being published. The 
Force Publish command always publishes all specified assets without performing any 
checking.
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8 Select the device to which the asset(s) will be published, or select the All Associated 
Devices command to publish the asset to the devices that where specified in the 
Publish Devices window in step 5.
The assets are immediately published to the device and its status appears in the Publish 
Progress window.

Monitoring and managing a device’s publish queue
When you are publishing a significant volume of assets to a single or multiple devices, we 
recommend using Xplorer’s Publish Queue Monitor window to monitor and manage a 
device’s publish queue.

The following sections provide information and instructions for monitoring and managing 
the publish queue for individual devices:

• Using Device Details to monitor a device’s publish queue, on page 45
• Using the Publish Queue Monitor to manage publishing, on page 46

Using Device Details to monitor a device’s publish queue
When the View>Show Device Details menu command is enabled, the following 
information is listed below the device’s icon:

• Freespace: Percentage of disk space still available on the device.
• Items Queued: The number of items currently in the device’s publish queue.
• Q. Status: The status of the queue during publishing. Normal indicates that everything 

is working as expected, while Blocked indicates that the throughput is too low to 
publish.

• Throughput: The data transfer speed/rate (Kb/s) at which publishing is operating.

The Device Details’ refresh rate is determined by the Publish Statistics Update Interval 
setting in Xplorer’s Publish Monitoring settings (see page 71). Another convenient way to 
view the most recent device details is to hover the cursor over the device’s icon.

Note: Although the Publish Progress window tracks and displays the 
status of the publishing of assets, Xplorer also allows you to view a 
Publish Transfer log file that documents in greater detail the publish 
process. After publishing, select the View>Publish Transfer Log 
command to open the Publish Transfer log file in Notepad.

Note: When Xplorer’s Device View toolbar button  is enabled, the 
Device Viewer expands to full screen and the Device Details 
information is automatically enabled below each device’s icon.
45



Moving assets to/from the XMS and other devices
Monitoring and managing a device’s publish queue
Using the Publish Queue Monitor to manage publishing
Xplorer’s Publish Queue Monitor allows you to monitor and manage the publish queue for 
a specific device. More specifically, the Publish Queue Monitor displays the current status of 
all of the publish queues for a particular publish location (device). In addition, the Publish 
Queue Monitor allows you to manage the device’s publish queue by reordering the items in 
the queue and also moving items from one queue to another so that they may be 
published concurrently.

The following sections provide information and instructions for using the Publish Queue 
Monitor:

• Opening the Publish Queue Monitor window, on page 46
• Monitoring the contents and progress of the device’s publish queue, on page 46
• Prioritizing items that are in the queue, on page 47
• Publishing items concurrently in different queues, on page 48

Opening the Publish Queue Monitor window

To open the Publish Queue Monitor window, right-click on a device in the Device Viewer 
and select the Publish Queue Monitor command.

If items are currently being published to the device when the Publish Queue Monitor 
window is opened, the publish item list will be populated. Otherwise, the publish item list 
will be empty until a publish request is executed to that publish location.

Monitoring the contents and progress of the device’s publish queue

When a publish request is executed to the device’s publish location, the items to be 
published will populate the publish queue list within the Queue 1 tab (default). 

The publish requests are executed sequentially in the queue. This means that the items at 
the top of the queue are currently being processed, followed by those that are next to be 
processed. 

Items in the queue that have been or are currently being processed are disabled (light gray) 
and cannot be selected. If the item is red, this indicates that several attempts to publish the 
item have failed.

Each column displays a property of the publish item in the queue, including its current 
status and completion progress.

Queue tabs

Items to be

Number of items 
left in the queue

published
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The rate at which the queue’s information is updated in the Publish Queue Monitor window 
is regulated by the Refresh Rate setting located in the toolbar. By default, the queue is 
automatically updated every 1 second, however, you may change the setting by clicking 
the  button and selecting a specific frequency rate (1, 2, 5 or 10 seconds) or Manual. 
Selecting Manual allows you to control the updating of the queue by clicking Refresh 
button  in the toolbar.

Once an item is successfully published to the device, you can remove them from the queue 
by clicking the Clear Complete button  in the toolbar

You may cancel items that are currently in the publish queue by selecting the items and 
then clicking the Cancel Selected button  in the toolbar. The status of the canceled 
items will indicate that the item’s publishing was canceled and the item will be disabled 
(gray) so that it cannot be reordered or reprioritized. We recommend removing canceled 
items from the publish queue.

Prioritizing items that are in the queue

Publish requests are executed sequentially, so that the items at the top of the queue list are 
processed first. The Publish Queue Monitor allows you manage the order in which items are 
published by moving items to a higher position so that they are published sooner, or delay 
publishing a queued item by moving it lower in the queue.

To reorder items in the publish queue, select the item, then drag and drop the item onto its 
new location in the queue. An orange bar appears while dragging to show exactly where 
the item will be placed when dropped. 

Note: You cannot move an item to the very last row of the queue - only 
to the second last item. 

Note: Items that are currently being processed in the queue cannot be 
reordered.
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Publishing items concurrently in different queues

The Publish Queue Monitor allows you to publish concurrently in five (5) queues. This is 
useful if you have a large item publishing (that is taking a long time) and you do not want to 
wait before publishing other items. 

When a series of publish requests are executed, by default the items are placed in the first 
queue (Queue 1 tab). By selecting and dragging items from the first queue to another 
queue tab, you will place the items in a separate publish queue that will start publishing 
simultaneously with the other queue. This avoids having to wait for the other items to 
finish.

Publishing the entire contents of one device to another device
Xplorer provides a quick and easy way to duplicate the complete asset contents of one 
device to another device.

To duplicate the contents of one device on another device:
1 Right-click on the recipient device and select the Copy from command.

2 Select the source device that contains the desired assets.
The following warning message appears.

3 Click Yes to proceed.
The entire asset contents of the source device are immediately entered into the 
destination device’s publish queue, which can be monitored using the Publish Progress 
window or the destination device’s Publish Queue Monitor window.
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Propagating assets from the Xmedia Server to another server
Propagation allows you to automatically or manually transfer and save assets stored on one 
server (i.e. XMS-1) onto another server (i.e. XMS-2) even though both of these servers are 
otherwise independent. This is accomplished by configuring the servers specifically for 
propagation, in which one server is the propagation server (master) and the others are 
propagation nodes (slaves). This configuration is perfomed in the XMS Panel on each of the 
servers, and is therefore described in the XMS Panel documentation, not in this Xplorer 
User Manual.

Once the propagation configuration is properly setup on the servers’ XMS Panel, no further 
setup is required in Xplorer. The automatic propagation will transfer, update, and save 
assets to the propagation nodes automatically when you do any of the following to an 
asset category that is associated to a propagation node:

• create a new asset
• edit an asset or the asset’s properties
• rename, recategorize, or delete an asset
• change or delete the asset’s proxy/thumbnail

If while working in Xplorer, you want to force the propagation of an asset or asset category, 
you can use the Propagate To command to execute a manual propagation.

To manually propagate assets from one server to another:
1 Open Xplorer on the propagation server (master).
2 Select the asset category or the asset that you want to propagate to a node server from 

the Asset Browser or Asset Gallery.
To select multiple assets to propagate, press the SHIFT key as you click on each asset for 
consecutive selections, or press the CTRL key to select a grouping of non-consecutive 
files.

3 Right-click on the selection and select the Propagate To command from the context 
menu. 

4 Select the recipient of the assets:
• Select All Associated Locations to propagate to all locations that are associated with 

that category or parent category
• Select the specific name of one of the node servers associated with the category to 

propagate only to that location.

The assets are immediately transferred to the selected node server(s).

Note: While propagation does require some initial setup, once it is 
properly configured it makes transferring assets quick and effortless. 
It is therefore ideal for situations where the transfer of assets between 
servers is frequently performed. If this is not the case, then it may be 
more beneficial to can transfer assets by exporting assets from one 
XMS and then importing them into another XMS manually (see 
page 50 and page 41).
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Exporting Vertigo asset files to another Xmedia Server
Exporting consists of saving Vertigo assets to files. Exporting is most commonly used for 
copying objects and assets from one server to another. For example, a broadcaster with 
several stations can replicate their look and feel at each station by exporting assets from 
one and importing them to the others.

Xplorer offers maximum flexibility by letting you export anything -- from an individual asset 
(e.g. an image file) to the entire contents of an asset type’s root category (e.g. Panels). 
Moreover, anything you export will automatically be accompanied by the assets used to 
build it, any proxy images, etc. For example, if exporting a control panel, all assets that were 
used to create it will be exported at the same time (e.g. Xmedia objects, image files, clip 
files, etc.).

To export one or more assets or asset categories:
1 Launch Xplorer and verify that the XMS icon appears in the Viewer.

If it does not, then see Starting Xplorer and connecting to the Xmedia Server, on page 5 
for instructions on how to configure the XMS for Xplorer.

2 Select the XMS icon. 
The contents of the Xmedia Server appears in the Asset Browser and Asset Gallery.

3 Select the appropriate asset category icon and navigate to the subcategory folder that 
contains the asset(s) that are to be exported.

4 Select the Export button  in the Xplorer toolbar.
The Export Assets window appears.

5 Drag and drop the assets, or the subcategory (if you want to export all of the assets in a 
subcategory), from the Asset Gallery to the Export Assets window (Figure 4-4).

Fig. 4-4: Export Assets window with assets selected for export

6 Check the Export Linked Assets check box.
7 When done, click OK. This displays the Create Export Destination Directory window.

Note: Selecting an item for export more than once will not create 
multiple copies.
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The File name field will contain a default name for the export which can be edited if 
desired. 

8 Browse to the folder where you wish to save the export and click Save. This creates a 
new folder containing a set of files which comprise the export.

Note: Transferring assets by exporting assets from one Xmedia Server 
and then importing them into another Xmedia Server manually is 
ideal for low volume and infrequent transfers. However, if you are 
frequently transferring assets between servers, we recommend using 
propagation to transfer assets. See Propagating assets from the 
Xmedia Server to another server, on page 49 for more information.
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Saving a local copy of an asset as a file
Xplorer allows you to save a copy of selected assets locally to your machine as a file. 

When saving the following asset types, Audio, Images, Cel animations, Clips, and Generic, 
Xplorer identifies the main file format that the asset can be saved as, as well as any 
alternative file formats (if applicable). 

Although Scenes and Templates assets can also be saved locally, they must be saved as 
.xml files.

The following asset types cannot be saved locally: Panels, Playlist, Segments, Rundowns, 
Scripts, Pages, Lookup Tables, Work Orders and Jobs.

To save a single asset on your local drive:
1 Right-click on the asset in the Asset Gallery and select the Save Local Copy command.

The command expands and asks you to choose the file format that you would like to 
save the asset as. 

• The Master format is the asset’s original file format.
• The Alternate formats are additional formats that the asset may be saved as.

2 Select the file format that the asset will be saved as.
The Save Local Copy window appears.

3 Navigate to the folder on your system where you want to save the files and click Save.

To save multiple assets on your local drive:
1 In the Asset Gallery, select the desired files by pressing the SHIFT key as you click on 

each asset for consecutive selections, or press the CTRL key to select a grouping of non-
consecutive files. 

2 Right-click on one of the selected assets and select the Save Local Copy command.
The Browse For Folder window appears.

3 Navigate to the folder on your system where you want to save the file and click OK.
Or,
Select a directory location and create a new folder in that location by pressing the 
Make New Folder button. Name the folder and then click OK.

Note: When saving multiple assets, the assets can only be saved as 
their current file format. Saving assets in alternate file formats must be 
done individually as described above.
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To help identify and manage the asset contents of the Xmedia Server and other devices, 
Xplorer allows you to preview the playout of audio clips, images, cel animations, and video 
clips. Although other asset types cannot be previewed, their proxy images are displayed in 
the Asset Gallery.

Xplorer also provides access to the Image Editor, which allows you to perform some basic 
image editing tasks on image assets like, adjusting the image’s color and sharpness, 
cropping the image, among others. Note that no other type of assets can be modified using 
Xplorer. 

The following sections provide information and instructions for previewing assets and 
modifying images:

• Previewing audio and video clips, on page 54
• Previewing cel animations, on page 55
• Previewing and editing image assets, on page 56
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Previewing audio and video clips
Previewing an audio or video clip asset in Xplorer opens a Windows Media Player window, 
which features typical transport controls (play, pause, stop, volume...etc.) for controlling the 
playout of the clip. Use the slider to display the playout of a particular frame, or to select the 
starting point at which the clip (audio or video) will begin when you select the Play button. 
Pressing the spacebar during playout pauses and restarts the playout of the clip.

Fig. 5-1: Audio / video clips are previewed in a media player type window

To preview an audio or video clip asset:
1 Select the XMS or a connected device from the Device Viewer.
2 Navigate through the Asset Browser until the desired asset is displayed in the Asset 

Gallery.
3 Either double-click the asset in the Asset Gallery, or right-click on the asset’s name and 

select the Preview command.
The asset immediately starts loading and then playing out in a separate media viewer 
window.
If for any reason the asset cannot be previewed, the Proxy Not Available icon appears.

Note: You cannot edit any aspect of the audio or video asset using the 
preview window or command.

Note: When clips and OXA/OXI cel animations are previewed in 
Xplorer, they are actually being played out from the Xmedia Server by 
opening a UNC path to the Xmedia Server. As such, should a clip ever 
fail to play in Xplorer, we suggest that you troubleshoot the problem 
by ensuring that the user logged into the machine running Xplorer 
has permission to access the Xmedia Server machine. In other words, 
the user of Xplorer must be able to successfully open a UNC path to 
the Xmedia Server by specifying the Xmedia Server by hostname 
(rather than IP address) in Windows Explorer.
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Previewing cel animations
Previewing a cel animation asset in Xplorer opens an independent preview window 
(Figure 5-2), which features a slider that allows you to manually playout the cel animation, 
as well as viewing the contents of a particular frame. 

The preview window’s title bar identifies the name of the cel animation and the length of 
the cel animation (total number of frames). When you move the slider, the title bar 
identifies the exact frame location that is being displayed.

Fig. 5-2: The Cel Animation preview window allows you to view the animation frame-by-frame

If the cel animation is an OXA or and OXI, you can preview the cel animation’s alpha channel 
by clicking the View Alpha Channel button  in the bottom-left corner.

To preview a cel animation asset:
1 Select the XMS or a connected device from the Device Viewer.
2 Navigate through the Asset Browser until the desired asset is displayed in the Asset 

Gallery.
3 Either double-click the asset in the Asset Gallery, or right-click on the asset’s name and 

select the Preview command.
The asset immediately starts loading in a separate media viewer window. Once 
completely loaded, you can use the slider to preview the cel animation.
If for any reason the asset cannot be previewed, the Proxy Not Available icon appears.

Note: You cannot edit any aspect of the cel animation asset using the 
cel animation preview window or command.
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Previewing and editing image assets 
Previewing an image asset in Xplorer opens an independent preview window, which allows 
you to see the image in its full size.

To preview an image asset:
1 Select the XMS or a connected device from the Device Viewer.
2 Navigate through the Asset Browser until the desired asset is displayed in the Asset 

Gallery.
3 Either double-click the asset in the Asset Gallery, or right-click on the asset’s name and 

select the Preview command.
The asset immediately appears in the preview window. 
If for any reason the asset cannot be previewed, the Proxy Not Available icon appears.

The image preview window does not allow you to make any edits to the image asset, 
However, Xplorer does provides you access to the Vertigo Suite’s Image Editor tool, which 
allows you to perform some basic image editing tasks on image assets like, adjusting the 
image’s color and sharpness, cropping the image, among others.

Fig. 5-3: The Image Editor allows you to perform some basic image editing tasks on image assets

The following sections provide functional descriptions and instructions for how to use the 
Image Editor to edit image asset:

• Opening the Image Editor, on page 57
• Zooming in/out and repositioning the image, on page 57
• Cropping an image, on page 59
• Making color adjustments, on page 61
• Adjusting the sharpness of an image, on page 62
• Using the Image Modification buttons to flip an image, on page 62
56



Xplorer
User Manual
Opening the Image Editor
To open the Image Editor from within Xplorer:

1 Select the XMS or a connected device from the Device Viewer.
2 Navigate through the Asset Browser until the desired asset is displayed in the Asset 

Gallery.
3 Right-click on the image asset in the Asset Gallery and select the Modify Image 

command.
The Image Editor window immediately opens and displays the image.

Zooming in/out and repositioning the image
When editing an image, it is often necessary to view the image, or a portion of the image, in 
greater detail. It is for this reason that the Image Editor allows you to magnify, or zoom in on 
the image, as well as zoom out to get an expanded or distanced view of the image.

As demonstrated below, when an image is opened in the Image Editor it is placed directly 
in the center of Editor’s canvas. However, when you zoom in on the image, you may not see 
certain areas of the image. To reposition the image within the display, while maintaining 
the zoom scale, you can pan across the image to the area that is otherwise outside of the 
window’s display. 

• Zooming in/out, on page 57
• Reposition the image by panning, on page 58

Zooming in/out

There are two (2) methods that you can use to zoom in on an image:
1 The Image Editor’s Zoom tool allows you to zoom in on a particular area on the image. 

• Click the Zoom button  on the Image Editor’s toolbar. 
Your pointer transforms into a magnifying glass. 

• Click the part of the image that you want to zoom in on.
The Image Editor zooms in on the image in increments.

2 You can zoom in on the image using your mouse or keyboard. Note, however, that this 
type of zoom operation zooms in on the center of the portion of the image that is 
currently displayed. As a result, you may need to pan across the image to view a 
particular area of interest.

• Roll the mouse wheel forward.
Or,

• Press the + (plus) key on your keyboard’s number pad.

Original image displayed (centered) Zoom in on the Image, but the upper
portion is now is not visible

Panned up to view the whole
statue, while still zoomed in.
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To zoom out of the image:
You can zoom out of the image using your mouse or keyboard. Note, however, that this 
type of zoom operation zooms out on the center of the portion of the image that is 
currently displayed. 

• Roll the mouse wheel backward.
Or,

• Press the - (minus) key on your keyboard’s number pad.
Or,

• Press the Space bar on your keyboard and the zoom is reset to the images original 
scale (1:1).

Reposition the image by panning

There are three (3) methods that you can use to reposition an image by panning:

Panning is only required, and therefore only available, when a portion of the zoomed image 
is not visible in the Image Editor’s canvas. In such a case, the canvas’ horizontal and/or 
vertical scroll bars become active.

1 The Image Editor’s Pan tool allows you to reposition an image using your mouse to 
drag the image around the Editor’s canvas. 

• Click the Pan button  on the Image Editor’s toolbar. 
Your pointer transforms into a hand. 

• Drag the image in the direction (up/down, and/or right/left) required to reposition 
and display the desired portion of the image in the Editor’s canvas.

2 You can reposition an image using the Editor’s canvas scroll bars. When an upper or 
lower portion of the image is not visible in the Editor’s canvas, the canvas’ vertical scroll 
bar appear. Similarly, when the right or left portion of the image is not visible in the 
Editor’s canvas, the canvas’ horizontal scroll bar appear.

• Drag the scroll box up/down and/or back/forth to reposition the image on the 
Editor’s canvas.

3 You can also use the keyboard’s direction keys (up, down, left, right, page up, and page 
down) to reposition the image in small increments.
58



Xplorer
User Manual
Cropping an image
The Image Editor’s cropping function allows you to conserve a selected portion of the 
image, while removing the remaining portions surrounding the selected area. Cropping is a 
popular image processing technique that is commonly used to focus the image on a 
particular subject or area on the image.

A bounding outline surrounds the image when it is opened in the Image Editor. The 
bounding outline is a frame that is used for defining the area of interest when using the 
cropping feature. In other words, the content inside of the bounding outline will be 
preserved, while whatever is outside the bounding outline will be permanently removed. 
When the Image Editor is in crop mode, dragging the bounding outline’s corner handles 
(squares) allow you use to resize the bounding outline around the area of interest on the 
image. If the “Use area of interest aspect ratio” check box is selected, then the bounding 
outline can only be resized to dimensions that maintain the aspect ratio of the image’s 
placeholder on the scene, template, or control panel. Clearing this check box allows you to 
resize the bounding outline freely without any aspect ratio restrictions.

When resizing or repositioning the bounding outline, its dimensions and location is display 
in the lower right corner of the Image Editor window (Figure 5-4). The first set of number 
displays the X/Y dimensions of the bounding outline in pixels, while the second set 
represents the location coordinates of the bounding outline’s upper left corner.

Fig. 5-4: The dimensions and location of the bounding outline

To crop an image:
1 Open the original image in the Image Editor (see page 57).
2 With the image completely visible in the Image Editor, click the Crop button .
3 Resize and/or reposition the bounding area to include only the content to be 

preserved.
a Select the Use area of interest aspect ratio check box if you want to resize the 

bounding outline, but still maintain the aspect ratio of the image’s placeholder on 

Crop the image if you want to focus on Use the crop and zoom features to resize

and reposition the bounding outline around

the portion of the image to be preserved.

The cropped image can be saved

using a new, or the same, name.only a portion of the original image.

Note: Since cropping permanently alters the image, the Image Editor 
allows you to save a copy of the changed image before the cropping 
is actually performed. As a result you can preserve the original state of 
the image asset.
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the scene, template, or control panel. Clear the check box is you want to freely 
resize the bounding area.

b Drag the bounding outline’s sizing handles to resize the bounding outline around 
the area of interest. 

c If necessary, you can reposition the bounding outline within the image by clicking 
inside the bounding outline and dragging it over the area of interest in the image. 

4 Once the bounding outline contains only the area of interest, click OK.
The Name new image window appears.

5 Save the cropped image:
• Select the Stretch image to fill placeholder check box if you want the Image Editor 

to enforce scaling so that the resulting image is the exact size of the placeholder. 
• Leave the Stretch image to fill placeholder check box clear (unchecked) you want 

to defer any scaling between the cropped image and its final space until playout 
time.

• If you want to preserve the original image asset, you can save the cropped image 
as a new image by typing in the name of the new image asset in the text box and 
then clicking OK on the Name new image window. 

• To replace the original image with the cropped image, leave the original image’s 
name in the text box and click OK.
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Making color adjustments
The Image Editor allows you to adjust the color properties of an image asset. Color 
adjustments are applied immediately to the entire image, not just a specific area of interest. 
You can experiment with different color settings, however there is no way to undo your 
changes except to click the Reset All button, which returns the color settings to the state 
they were in when the image was last saved, or by clicking Cancel, which closes the Image 
Editor and the image asset remains unchanged.

Figure 5-5 and the following table demonstrate that you adjust the image’s color properties 
by moving the property’s slider to the right or left.

Fig. 5-5: The Image Editor’s color adjustment sliders

Contrast The difference in the luminance of the brightest and the darkest areas of an 
image. A high contrast will display an obvious difference (i.e. black versus white) 
in the luminance between two areas, while a low contrast makes the difference 
less obvious or more gradual (i.e. shades of grey).
• Move the slider to the right to increase the image’s contrast ratio.
• Move the slider to the left to decrease the image’s contrast ratio.

Brightness Generally, the brightness setting determines how light or dark a the colors of the 
image are based on how close the colors are to white. The more white a color has, 
the brighter it is.
• Move the slider to the right to increase the image’s brightness (until all white)
• Move the slider to the left to decrease the image’s brightness (until all black)

Saturation Saturation refers to the intensity of a specific hue. It is based on the color's purity; 
a highly saturated hue has a vivid, intense color, while a less saturated hue 
appears more muted and grey. With no saturation at all, the hue becomes a shade 
of grey.
• Move the slider to the right to increase the image’s saturation.
• Move the slider to the left to decrease the image’s saturation.

Gamma Alters the contrast of the mid-tone colors with little effect on pure white or black, 
which is the function of the Contrast property above. Increasing the gamma ratio 
increases the image’s highlight to shadow contrast in terms of mid-tone colors’ 
density values. Decreasing the gamma setting intensifies the shadows amongst 
the mid-tone colors.
• Move the slider to the right to increase the image’s gamma setting.
• Move the slider to the left to decrease the image’s gamma setting.
61



Previewing assets in Xplorer
Adjusting the sharpness of an image
Adjusting the sharpness of an image
The Image Editor allows you to adjust the sharpness setting of an image asset. The 
sharpness adjustment is applied immediately to the entire image, not just a specific area of 
interest. You can experiment with different settings, however there is no way to undo your 
changes except to click Reset, which returns the sharpness setting to the state it was in 
when the image was last saved, or by clicking Cancel, which closes the Image Editor and 
the image asset remains unchanged.

You adjust the image’s sharpness property by moving the property’s slider to the right to 
increase the focus and to the left to blur the image.

Using the Image Modification buttons to flip an image
The Image Editor allows you to quickly change the orientation of an image by flipping it 
horizontally or vertically. Figure 5-6 demonstrates that the Image Modification section of 
the Image Editor’s interface features two buttons: Flip Horizontal and Flip Vertical. Click 
these buttons to immediately flip the image, and click the button again to return to the 
original orientation.

Fig. 5-6: The Image Editor’s Image Modification buttons allow you to quickly flip image assets
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Although many of Xplorer’s commands and settings are described within the context and/
or procedures to which they apply, the following sections provide a quick reference to their 
functional descriptions:

• Xplorer’s menu commands, on page 64
• Xplorer’s toolbar buttons, on page 66
• Xplorer’s settings, on page 67
 63



Xplorer’s commands and settings
Xplorer’s menu commands
Xplorer’s menu commands
Many of Xplorer’s key features are thematically organized within the menu bar command 
structure at the top of the main interface window.

The following sections provide functional definitions of the Xplorer menu commands
• File menu, on page 64
• View menu, on page 64
• Tools menu, on page 65
• Help menu, on page 66

File menu
The File menu contains two (2) commands that are related to ingesting files into the system 
and closing the Xplorer application.

View menu
The View menu contains commands that are related to how and what will be displayed in 
the Xplorer interface. 

Ingest Opens the Ingest Files window, which allows you to create assets 
from files that are not native to the Vertigo Suite applications, e.g. 
image and audio files. These files are made into assets, so that they 
can be used within the Vertigo Suite.
See Ingesting third-party content files, on page 33 for instructions on 
using this command.

Exit Allows you to close the Xplorer application.

Thumbnails Displays the contents of the Asset Gallery as individual thumbnail 
images, which makes it easy to visually recognize and differentiate 
individual assets. The alternative to the Thumbnails display format is 
Details.
Alternative access:
• ProxyView toolbar button: 

Details Displays the contents of the Asset Gallery in a list, which provides 
property details about each of the individual assets (i.e. Name, Format. 
The alternative to the Details display format is Thumbnails.

Alternative access:
• Detail View toolbar button: 
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Tools menu
The Tools menu contains commands that allow you to specify some of settings that affect 
the aesthetic and behavioral properties of Xplorer. It also allows you to configure Xplorer to 
interact with other storage devices.

Show Device Details When enabled, Xplorer displays the following information under each 
device in the Device Viewer:
• Freespace: The amount of free disk space available (percentage) on the device. 
• Items Queued: The number of items that are currently in the device’s publish 

queue.
• Q. Status: The status of the queue during publishing. Normal indicates that 

everything is working as expected, while Blocked indicates that the throughput 
is too low to publish.

• Throughput: The data transfer speed/rate (Kb/s) at which publishing is 
operating.

See Using Device Details to monitor a device’s publish queue, on page 45 
for more information.

Log File When selected, this command opens the current log file in Notepad. The 
log file stores the processes and errors that occurred during your Xplorer 
session and is useful when debugging.

Publish Transfer Log Displays the Publish Transfer log file, which reports the processes and 
errors that occur for each asset that is published during the Xplorer 
session. 
See Publishing assets from the Xmedia Server to a device, on page 42 for 
more information on publishing assets.

Publish Progress Displays or hides the Publish Progress window, which allows you to see a 
list of all of the assets that have been published during the current 
Xplorer session. Note that closing this window clears the list.
See Publishing assets from the Xmedia Server to a device, on page 42 for 
more information on publishing assets

Settings Opens the Settings window, which is used to establish the aesthetic 
and behavior of many of the Xplorer features. See Configuring 
Xplorer’s settings, on page 9 for a functional description of each 
setting.

Configure Devices Opens the Device Configuration window, which allows you to define 
a new device to be added to the Device Viewer. See Adding devices to 
Xplorer’s Device Viewer, on page 10 for more information.

Station Manager The Station Manager allows you to add and configure devices to the 
Xmedia Server. These devices can then be grouped together into 
channels which are used by panel’s created in the Xpanel application. 

Classic Search Opens the XMS Search tool, which allows you to perform standard or 
advanced searches for assets on the Xmedia Server. See "Using the 
Search Tool" in the Xnews User Manual for a full description and 
instructions.
Although this search tool is available, we recommend that you 
instead use the Search XMS feature in Xplorer’s toolbar. See 
Searching for assets stored on the Xmedia Server, on page 19.
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Help menu
The Help menu contains commands that provide Xplorer product information, like 
licensing and software version identification

Xplorer’s toolbar buttons
The toolbar along the top-left side of the Xplorer interface contains a series of buttons that 
allow you to choose the working view of the Xplorer interface, set the display format of the 
Asset Gallery and perform other actions with respect to moving, finding, and publishing 
assets.

The following table provides a functional description of each button on the Xplorer toolbar:

About Displays information about the version of Xplorer that you are using.

License Opens the License Manager window, which allows you to copy the 
customer ID and send it to our Technical Support team. Once you receive 
your license key, paste it into the License Key box. See page 4 and page 6 
for more information.

 

Category Browser View
Determines the active, working view of the Xplorer interface, which displays 
the Asset Browser and the contents of the Asset Gallery in either Proxy View or 
Detail View. 

 

XMS Search Results View
Determines the active, working view of the Xplorer interface, which displays 
the results of the XMS Search in either Proxy View or Detail View. 

 

ProxyView
Displays the contents of the Asset Gallery as individual thumbnail images, 
which makes it easy to visually recognize and differentiate individual assets. 
Alternative access:
• Menu command: View>Thumbnails

 

Detail View
Displays the contents of the Asset Gallery in a list, which provides property 
details about each of the individual assets (i.e. Name, Format).
Alternative access:
• Menu command: View>Details

 

Reload
Refreshes the selected category to ensure that it contains the most updated 
version of the assets.

 

Import
Opens the Select VertigoXmedia Asset Export File window, which allows you 
to navigate to the VxM Export file (*.exp) that is native to the Vertigo 
products and import it into the central XMS. See See Importing content files 
that are native to the Vertigo Suite system on page 41 for more information.
66



Xplorer
User Manual
Xplorer’s settings
To better suit your preferences or operating circumstances, Xplorer allows you to configure 
some settings. Note that since the default settings are appropriate for most operating 
circumstances, modifying these settings are entirely optional.

Xplorer’s settings are edited in the Settings window, which can be accessed by:
1 Select Tools>Settings from the Xplorer menu commands.  

This displays the Settings window.

2 After making changes, click OK to register the information and close the window.
Or,
Click Apply to register the information and keep the window open.
Or,
Click Cancel to ensure that no changes made since the last time you clicked OK.

 

Export
Allows you to select assets from the central XMS’s Asset Gallery to be exported 
and saved in a VxM Asset Export Directory on your system. See Exporting 
Vertigo asset files to another Xmedia Server, on page 50 for more information.

 

Ingest
Allows you to create assets from files that are not native to the Vertigo Suite, 
e.g. image and audio files. See Ingesting third-party content files, on page 33 
for more information.

 

Work Order
Opens the Work Order window, which allows you to create a new work order. 
The work order system requires users to login using a user name and password. 
User names and passwords are registered and stored on the Xmedia Server 
using the Xmedia Server’s properties panel. See Creating and using work 
orders, on page 75 for more information.

 

Device View
When enabled, the devices section of the Device Viewer becomes full screen 
and each device’s details are automatically displayed.
This view is useful when you need to monitor and manage a large number of 
devices.
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XMS settings
The Settings window has six thematic tabs, which contain properties and settings that 
apply to Xplorer. A functional description of each setting is provided in the following 
sections:

• XMS settings, on page 68
• Work Order settings, on page 69
• Layout settings, on page 70
• Publish Monitoring settings, on page 71
• General settings, on page 72
• Logging settings, on page 73

XMS settings
The XMS settings specify the locations of the main Xmedia Server, as well as the backup 
XMS (if applicable), which contains all of the assets, i.e. all building blocks used in the 
creation of broadcast graphics. The Xmedia Server is also where playlists, templates, 
images, etc., are stored. 

The following settings are displayed on the XMS settings tab:
• Servers > XMedia Server IP Address - Specifies the IP address of the machine running 

the XmediaServer. 
• Servers > XMedia Server Port - Specifies the port on which the Xmedia Server is 

listening.
• Backup Servers > XMedia Server IP Address - Specifies the backup server’s IP address 

used in case of failure of the primary Xmedia Server.
• Backup Servers > XMedia Server Port - Specifies the backup server’s port used in 

case of failure of the primary Xmedia Server.

Note: Some settings will require you to restart Xplorer for the changes 
to be applied.
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Work Order settings
If your system does not contain a particular image, clip, or cel animation, you can create and 
track a work order, which submits a request from the graphics department. See Creating 
and using work orders, on page 75 for procedural information.

The following settings are displayed on the Work Order settings tab:
• Work Order Printer - Specifies the printer device that is used as the default when the 

Print command is used on the Work Order window.
• Rows in WO job list - This setting determines the number of rows are always visible in 

the job list portion of the Work Order window. Since most work orders contain a small 
number of jobs, the default value of 3 is reasonable. If there are more than three jobs in 
the work order, you can always scroll down through the list to view the additional jobs. 
If you routinely add numerous jobs to a work order, this setting can be set to a larger 
number so that you can see all the jobs without having to scroll. Note that the 
minimum permitted value is 3 and the maximum permitted value is 10.

• Enable Work Orders - When enabled (check), this setting enables the Work Orders 
feature and displays the Work Orders button in the Xplorer toolbar. When disable 
(unchecked), the Work Orders functionality is hidden.

• Highlight OverDue WO - Highlights work orders that are past their due date in red.
• WO due date tolerance (days:hours) - Sets the tolerance for identifying an approaching 

completion deadline for a work order. When the Highlight OverDue WO setting is 
enabled, a work order whose due date falls within the tolerance setting is highlighted 
in red. The format of the this setting value is Day:Hours and the higher the tolerance 
value is, the more advance warning is provided. For example, a tolerance value of 1:18 
means that the work order will remain highlighted in red one day and eighteen hours 
prior to being overdue.
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Layout settings
The Layout settings tab allows you to set specific parameters that affect the aesthetic or 
visual look of the Xplorer interface.

The following settings are displayed on the Layout settings tab:
• Thumbnail Size > Tile Width - Specifies the width of the thumbnail image that will be 

displayed when Xplorer is set to Proxy View (see page 17). Selecting the Reset button to 
the right of this setting, returns the thumbnails to their default size of 160.

• Device Viewer > # of Rows - Specifies the layout (number of rows) of how the devices 
will be listed and displayed in the Device Viewer pane of the Xplorer interface (see 
page 7).
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Publish Monitoring settings
The Publish Monitoring settings tab allows you to set specific parameters related to the 
updating of a device’s publish statistics and logging. See Monitoring and managing a 
device’s publish queue, on page 45 for related information.

The following settings are displayed on the Publish Monitoring tab:
• Publish Statistics Update Interval- Specifies the frequency at which the Device Details 

(related to publishing) in the Device Viewer are updated. The default value is 1 minute.
• Device Publish Statistics Logging - Turns on logging of the updating of device 

information (Freespace, ItemsQueued) that occurs when the Show Device Details 
command is enabled.

• Publish Monitor Logging - Turns on logging in the Publish Queue Monitor window 
opened.
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General settings
The General settings tab allows you to set the Default TV Format setting, which determines 
the default values to set in the Multi-Image Ingest window when a new Targa sequence is 
ingested. For example, if the default format is NTSC, when a Targa sequence is ingested, the 
default value in the Multi-Image Ingest window for cel animations will show NTSC as the 
format of the cel animation.
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Logging settings
Xplorer’s Logging settings allow you to specify the categories of events that you want to be 
recorded in the Xplorer log files, as well as the maximum number and size of Xplorer log 
files that will be archived. 

As Xplorer operates, events are recorded to a log text file, which is stored under the 
Windows system directory for application specific data.

Since the log files thoroughly track and record Xplorer’s events during operation, they are a 
great tool to use for diagnosing error conditions or unexpected behaviors. In fact, the 
Technical Support team will often ask its customers to send them the Xplorer log file to help 
them troubleshoot any unexpected behavior that you may be experiencing.

• Log Level - This sets the default log level used by all logging categories except those 
that have been checked in the Debug Categories list. The choices are:

• Error - Only log errors and essential operations.
• Warn - Log unsuccessful operations that may indicate a problem (in addition to all 

messages logged at the Error level).
• Info - (Default) Log important events that occur during normal conditions (in 

addition to all messages logged at the Warn level).
It is recommended to set the Log Level to Info in order to provide enough information 
in the logs to diagnose common problems without affecting performance.

• File Size - Sets the maximum memory size for each log file created per run. The default 
value is 6 MB.

• File Count - Specifies the maximum number of Xplorer*.log files that will be stored. A 
large enough number should be chosen to store over a day's worth of logs. This way if a 
problem happens the relevant log files will be available. Once the maximum number of 
files is reached, the oldest log file will be replaced by a new one. The default value is 5.

• Debug Category List - Select the types of debug logging (categories) that you would 
like to record in the Xplorer log file:

• General - General logging that does not fit under any other category.
• VxmsApi - Logs client-side calls to the Xmedia Server.
• VxmsTcp - Logs client-side socket communication with the Xmedia Server using 

the principal Xmedia Server connection.
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• VxmsCache - Logs client-side activity in the Xmedia Server cache.
• VxmsTcpLayer - Logs client-side socket communication with the Xmedia Server 

used by the cache and publishing.
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While searching for an asset or perusing the contents of the Xmedia Server, you may realize 
that the system does not contain a specific image or video clip asset that you require for 
your template-based page. In such a case, Xplorer allows you to access to the Vertigo Suite’s 
work order system. A work order is a documented request to your graphics department 
that an asset with specific requirements be created and ingested into the Xmedia Server. 
Xplorer also allows you to view all of the work orders and jobs on your system through the 
Asset Browser’s Work Orders and Jobs categories.

The following sections describe creating and using work orders and jobs in the context of 
the Xplorer application:

• Creating a new work order, on page 76
• Viewing existing work orders and/or jobs, on page 77
• Adding a job to an existing work order, on page 78
• Removing a work order or job from the XMS, on page 79
• Fulfilling jobs using assets stored on the Xmedia Server, on page 80
• Fulfilling jobs using images from the AP Graphics Bank, on page 81
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Creating a new work order
If the Xmedia Server does not contain an image or video clip asset that you require for your 
template-based page, you can create a work order and job request. The work order’s job 
requests that your graphic arts department create an asset that fulfills your prescribed 
specifications and requirements and then ingest it into the system for your use.

Before creating a work order or job from the Xplorer application, your Xmedia Server 
system must first be configured to contain a work order workflow. You must also have the 
correct permission settings in your user profile to allow you to create work orders and jobs.

To create a new work order:
1 Ensure that the Enable Work Orders setting is enabled (Tools>Settings>Work Order 

tab).
2 Select the Work Order button  from the Xplorer toolbar.
3 Each time you begin a new Xplorer session and you attempt to create or access a work 

order or a job, the VertigoXmedia Login window appears and prompts you to sign in 
using a user name and password. If you do not have a user name and password, contact 
your IT department and ask them to add you to the Xmedia Server’s Workflow>Users 
properties in the Xmedia Server’s control panel.

Once you enter your user name and password, click OK and the Work Order Window 
appears.

4 In the Summary text box, type a short description of what playlist or rundown the work 
order applies to (i.e. 11PM news).

Note: The entire login step is avoided if the Windows user name 
matches the user name in the XmediaServer Properties’ Workflow 
options. If this is the case, then the user will automatically be logged 
on under the logged in name and the VertigoXmedia Login window 
does not even appear.
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5 In the Due field, specify the date and time by which all of the jobs in the work order are 
required to be finalized in the system. You can either type the date directly in the date 
text box, or click the drop-down arrow to open and use a calendar to select the date. 
Similarly, you can either type the time in the text box, or select use the up and down 
arrows.

6 In the Priority drop-down list, select one of the available priority levels to indicate to 
the graphic arts department the urgency of the work order request. The priority levels 
are: Low, Normal, High, and Urgent. The meaning and use of the priority levels should 
be determined within your organization and configured in the Priorities workflow 
options on the XMS Panel application.

7 The first job is automatically created when the work order is created. The job is already 
listed in the Jobs table and its properties are ready to be filled in. Instructions for 
creating an image or clip job request are provided on page 78.

8 Once the page(s) are created for the work order, you must save the work order by 
clicking the Save button  in the toolbar.

9 The Work Order dialog automatically closes and the new work order is entered into the 
system.

Viewing existing work orders and/or jobs
All saved work orders and jobs are stored on the Xmedia Server. You can view and open 
existing work orders and jobs using Xplorer’s Asset Browser and Asset Gallery.

To view a list of the existing work orders and open a specific work order:
1 Select the XMS in the Xplorer Device Viewer.
2 Select the Work Orders root category icon  in the Asset Browser.

A list of all of the existing work orders now appears in the Asset Gallery.
3 Optional - If you cannot find the work order that you are looking for, use the Filters tool 

in the lower portion of the Asset Gallery to place restrictions on the listing.
4 To open a work order, simply double-click the work order’s row in the Asset Gallery’s 

list. The Work Order window opens and displays all of the work order information and 
lists the jobs associated with the work order.

To view a list of the existing jobs and open a specific job:
1 Select the XMS in the Xplorer Device Viewer.
2 Select the Jobs root category icon  in the Asset Browser.

A list of all of the existing jobs now appears in the Asset Gallery.
3 Optional - If you cannot find the job that you are looking for, use the Filters tool in the 

lower portion of the Asset Gallery to place restrictions on the listing.
4 To open a specific job, simply double-click the job’s row in the Asset Gallery’s list. 

The Job window opens and displays all of the information associated with the job.
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Adding a job to an existing work order
To add a new job to an existing work order:

1 Open an existing work order. See Viewing existing work orders and/or jobs, on page 77 
for instructions.
The Work Order window appears and displays all of the work order information and 
lists the jobs associated with the work order.

2 To add a new job, select the Add Job button  in the Work Order toolbar. 
A job is added to the Jobs list.

3 In the Title field, type a short title that describes the subject of the image or clip 
requested.

4 In the Assignee field, select from the drop-down list the name of the person that you 
want to assign the job to (i.e. the name of the graphic artist). 

5 In the Comment tab’s text box, provide instructions and/or specifications to guide the 
graphic artist, so that they can provide you with an image or clip that meets your 
specific requirements.

6 Click the Save Work Order button to save the job and the work order. 
If no Assignee was specified for the job, then the Job’s status becomes Pending and the 
assignment must be done as a separate step.
If however, an assignee was specified the job’s status becomes In progress and the job 
is sent to the assignee.

Note: The user names that appear in the Assignee drop-down list are 
limited to only those who are assigned the same role as the Target 
Role setting on the Assign Transition’s properties on the XMS Panel 
application. Therefore, if the desired user’s name does not appear in 
the Assignee list, verify that the user’s role and the Assign transition’s 
properties match.

Note: You can save a job without a placeholder, then use the Search or 
Ingest buttons to locate and attach a placeholder to the job. This 
placeholder will not exist on any page at this point, but it can be 
dragged afterward onto a page, or simply left alone in its category. 
 
Note that in the distributed work order case, on the hub the Ingest 
and Search buttons are disabled for empty-placeholder jobs because 
only spokes are allowed to make placeholders for distributed work 
orders.
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Removing a work order or job from the XMS
As a content management tool for the Xmedia Server, Xplorer is able to remove (delete) 
unwanted work orders and jobs from the Xmedia Server.

To delete a work orders or job from the Xmedia Server:
1 Select the XMS in the Xplorer Device Viewer.
2 Select the Work Orders root category icon  or the Jobs root category icon  in the 

Asset Browser.
A list of all of the existing work orders or jobs appears in the Asset Gallery.

3 Optional - If you cannot find the work order or job that you are looking for, use the 
Filters tool in the lower portion of the Asset Gallery to place restrictions on the listing.

4 Select the work order or job that you want to remove, or to select multiple work order/
jobs, press the SHIFT key as you click on each one for consecutive selections, or press 
the CTRL key to select a grouping of non-consecutive work orders/jobs. 

5 Right-click on the selection and select the Delete command.
6 The Delete WorkOrder window appears and asks you to confirm your intention to 

delete the work order(s) or job(s).
7 Click OK.
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Fulfilling jobs using assets stored on the Xmedia Server
The XMS Search button on the Work Order and Job windows opens the Search XMS 
window, which allows you to quickly search and find assets on the Xmedia Server. Once a 
search is launched, assets that match the name, type, description, author, keywords and/or 
Recall ID are displayed in either a Proxy View or Detailed View and ordered by relevance to 
the search criteria. You can then use the assets listed to fulfill the job request.
Note:The Search XMS window uses Solr, which a web-based solution by the Apache 
group that performs fast searches across large amounts of data. The Xmedia Server must 
maintain a connection to Solr so that it can create an index of the database. See the 
Xmedia Server Configuration Guide for more information.

To search for assets stored on the Xmedia Server:
1 Open an unfulfilled job in the Work Order window or Job window.
2 Click the XMS Search button  to open Search XMS window.

3 Type a search query in the Search XMS text box. 
See Search query syntax supported by the Search XMS, on page 20 for descriptions and 
examples of the syntax you can use to build more effective search queries.

4 Optional: Limit Search XMS results to specific asset types. 
By default, all asset types are evaluated by the search query as indicated by the Type 
drop-down box set to All Types. One exception however, is if the job already has a 
placeholder associated with a page or template. In this case, the Type is already 
restricted based on the asset type of the placeholder.

• To limit the search results to one asset type, select an asset type from the Type 
drop-down list. 

• To limit the search results to either the Image or Clip asset type, click the browse  
button to open the Select Types To Search dialog. Select the asset types that you 
want included in the search and uncheck the asset types that you want excluded 
from the search results. Click OK.

5 Click the  button to launch the search.
Assets that satisfy the search query are displayed in the Results pane of the Search XMS 
window. 

6 Browse, sort and add an asset to the job.
• When the Proxy View button  is selected, the assets appear as thumbnails in 

order of relevance to the search criteria. Double-clicking the asset’s thumbnail 
automatically adds the asset to the job.

• When the Detail View button  is selected, the assets are listed in a table and 
sorted by relevance to the search criteria. Clicking the column headings allows you 

Note: When the Graphics Bank Enabled setting is selected on the 
Xmedia Server Control Panel, the Search button in the Work Order and 
Job windows is shared by two search tools: XMS Search and AP Search. 
If the AP Search button is currently displayed, click the arrow and 
select the Search XmediaServer option.
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to sort the results based on that column. Double-clicking the asset’s row 
automatically adds the asset to the job.

Fulfilling jobs using images from the AP Graphics Bank
The Associated Press (AP) Graphics Bank is a breaking news and archive image service that 
offers an extensive selection of images for on-air broadcasters. 

When the Graphics Bank Enabled check box is selected on the Xmedia Server Control Panel, 
the Search button in the Work Order window provides integrated access to the AP Graphics 
Bank allowing you to search for suitable images to fulfill the job.

To fulfill an image request job using the AP Graphics Bank:
1 Ensure that the AP Graphics Bank settings are enabled and configured on the Xmedia 

Server Control Panel. See “Enabling AP Graphics Bank components” in the Xmedia 
Server Configuration Guide.

2 Open a job in the Work Order window (see page 77). 
The Search button in the Work Order window allows searching in both the Xmedia 
Server and in the AP Graphics Bank. 

If the XMS Search button is currently displayed, click the arrow and select the Search AP 
Graphics Bank option.

3 Click the AP Search button.
The AP Graphics Bank: Search window appears. 

4 Search for a suitable image by entering a search query (keyword or boolean string) in 
the text box and clicking the search  button.

5 Once you have found an image that you want to use, select one of the following 
options from the drop-down button below the Sort field:

Note: If an expected asset is not returned in the search results, it may 
be because user rights management is enabled on the Xmedia Server 
and the current user does not have permission to view the asset. See 
“User Rights Management” in the Xmedia Server Configuration Guide 
for more information.
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6 Purchase the selected image and set the image’s properties.

Purchase and Ingest Ingest the high resolution version of the selected image and 
use this image to replace the placeholder in the current Job. 
This operation constitutes a purchase of the image and the 
AP Graphics Bank: Purchase Images window appears.

Purchase, Ingest & 
Attach

Ingest the high resolution version of the selected image and 
use this image to replace the placeholder in the current Job. 
In addition, add the image as an attachment in the Job. 
This operation constitutes a purchase of the image and the 
AP Graphics Bank: Purchase Images window appears.  
The image added as an attachment to the Work Order job 
can be saved to disk.

Purchase and 
Attach

Download the high resolution version of the selected image 
and add the image as an attachment in the Job. 
This operation constitutes a purchase of the image. 
The image is added as an attachment to the Work Order job 
and can be saved to disk.
Note that the image is not ingested into the Xmedia Server.

Ingest Preview Ingest the low resolution preview version of the selected 
image and use this image to replace the placeholder in the 
current Job. 
This operation does not constitute a purchase of the image. 
However, to finalize the Job using the preview image, the 
image must be purchased.

Note: When a Playlist Verification is performed in Xbuilder or Xplay, if 
an element in a playlist contains one or more AP Graphics Bank 
preview images that have not been purchased, the status of that 
element displays as Assets Awaiting Purchase until the images are 
purchased.
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Grass Valley Technical Support
For technical assistance, contact our international support center, at 
1-800-547-8949 (US and Canada) or +1 530 478 4148.

To obtain a local phone number for the support center nearest you, please consult the 
Contact Us section of Grass Valley’s Web site (www.grassvalley.com).

An online form for e-mail contact is also available from the Web site.

Corporate Head Office
Grass Valley
3499 Douglas-B.-Floreani
St-Laurent, Quebec  H4S 2C6
Canada
Telephone: +1 514 333 1772
Fax: +1 514 333 9828
www.grassvalley.com
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